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Chapter 1 — General Information

1-1

The Site Master User Guide is part of a set of manuals that describe all of the instrument

Introduction

functions and their use. This manual covers the instrument overview, system functions and
other common features, along with a brief guide to basic measurement concepts and setups.
Instrument operations are explained in various document types as listed below.

Additional Documentation

Part Number

Description (Required Option)

10100-00065

Important Product Information, Compliance, and Safety Notices

10580-00349

Spectrum Analyzer Measurement Guide
PIM Hunting

Interference Analyzer (Option 25)
Channel Scanner (Option 27)

C/W Signal Generator (Option 28)
Gated Sweep (Option 90)

Coverage Mapping (Option 431)

EMF Measurements (Option 444)
AM/FM/PM Analyzer (Option 509)

10580-00240

High-Accuracy Power Meter (Option 19)
Power Meter (Option 29)

10580-00241

Cable and Antenna Analyzer

10580-00242

2-Port Transmission Measurement Guide (Option 21)
Bias-Tee (Option 10)

10580-00253

Site Master Maintenance Manual

10580-00256

SCPI Programming Manual

10580-00280

PIM Master User Guide
PIM Analyzer (supported on legacy instruments only)

10580-00415

CPRI LTE RF Analyzer Measurement Guide
CPRI LTE RF Measurements (Option 752; requires Option 759)

The combined Options 752 and 759 are equivalent to obsolete Option 751.

10580-00434

OBSAI LTE RF Analyzer Measurement Guide
OBSAI LTE RF Measurements (Option 753; requires Option 759)

10580-00455

EMF Measurement Guide (Option 444)

11410-00484

Site Master Technical Data Sheet
Performance Specifications, Instrument Options and Accessories

Site Master User Guide
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1-2 Instrument Description General Information

Read the Handheld Instruments Product Information, Compliance, and Safety Guide

(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the
equipment. For additional information and literature covering your product, visit the product
page of your instrument and select the Library tab:

http://www.anritsu.com/en-US/test-measurement/products/s331e
http://www.anritsu.com/en-US/test-measurement/products/s332e
http://www.anritsu.com/en-US/test-measurement/products/s361e
http://www.anritsu.com/en-US/test-measurement/products/s362e

Contacting Anritsu for Sales and Service

To contact Anritsu, visit the following URL and select the services in your region:
http://www.anritsu.com/contact-us.

1-2  Instrument Description

The Site Master S331E/S361E is a handheld cable and antenna analyzer designed to make
Return Loss, VSWR, Cable Loss, and Distance-To-Fault (DTF) measurements in the field.
The cable and antenna analyzer also includes 1-port phase and smith chart measurements.
The 2-port transmission measurement option includes two power levels and access to a
built-in 32 volt bias tee (Option 10).

The S332E/S362E is an integrated multi-functional test instrument that eliminates the need
to carry and learn multiple test sets. In addition to the cable and antenna measurements, the
S332E/S362E can be configured to include a Spectrum Analyzer, 2-port Transmission
Measurement, Interference Analyzer with Interference Mapping capabilities, Coverage
Mapping, Channel Scanner, CW Signal Generator, AM/FM/PM Analyzer, PIM Analyzer,
Power Meter, and High Accuracy Power Meter. A GPS receiver can be added to both the
S331E/S361E and the S332E/S362E Site Master models.

The bright 8.4 in TFT color display provides easy viewing in a variety of lighting conditions.
All Site Master models are equipped with a Li-Ion battery delivering more than four hours of
battery life for the S331E/S361E and more than three hours of battery life for the
S332E/S362E Site Masters.

The combination of a touch screen and keypad enables users to navigate menus with the
touch screen and enter numbers with the keypad.

The internal memory is large enough to store approximately 2,000 traces or setups.
Measurements and setups can also be stored in a USB memory device or transferred to a PC
using the included USB cable. Ethernet connectivity is available using Option 413.

Not all after-market USB drives are compatible with the instrument. Many drives
come with a second partition that contains proprietary firmware. This partition must

Note be removed. Only one partition is allowed. Refer to the individual manufacturer for
instructions on how to remove it. You may also try reformatting a drive that
contains a single partition using FAT32 format.
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http://www.anritsu.com/en-US/test-measurement/products/s331e
http://www.anritsu.com/en-US/test-measurement/products/s332e
http://www.anritsu.com/en-US/test-measurement/products/s361e
http://www.anritsu.com/en-US/test-measurement/products/s362e
http://www.anritsu.com/contact-us

General Information

1-2 Instrument Description

Available Models
Table 1-1 lists the Site Master models described in this User Guide.

Table 1-1. Site Master Models
Model Frequency Range
S331E |Cable & Antenna Analyzer, 2 MHz to 4 GHz
S332E |Cable & Antenna Analyzer, 2 MHz to 4 GHz
Spectrum Analyzer, 9 kHz to 4 GHz
S361E |Cable & Antenna Analyzer, 2 MHz to 6 GHz
S362E |Cable & Antenna Analyzer, 2 MHz to 6 GHz

Spectrum Analyzer, 9 kHz to 6 GHz

Available Options

Available options for the Site Master are shown in Table 1-2.

Table 1-2. Available Options

S331E S332E S361E S362E Description
Bias-Tee (requires Option 21 on
S331E-0010 |S332E-0010 |S361E-0010 |S362E-0010 8331Ean(d 3361E) P
S331E-0019 [S332E-0019 [S361E-0019 [S362E-0019 [High-Accuracy Power Meter(")
S331E-0021 |S332E-0021 |S361E-0021 |S362E-0021 |2-Port Transmission Measurement
S332E-0025 S362E-0025 |Interference Analyzer(®)
S332E-0027 S362E-0027 |[Channel Scanner
C/W Signal Generator (requires
S332E-0028 S362E-0028 CwW Siggnal Generator Iéit)q
S332E-0029 S362E-0029 |Power Meter
S331E-0031 |S332E-0031 |S361E-0031 |S362E-0031 gE§ Eﬁ;“g (requires Anritsu
S332E-0090 S362E-0090 |Gated Sweep
Standard Calibration to ISO17025
S331E-0098 |S332E-0098 [S361E-0098 [S362E-0098 |and ANSI/NCSL Z540-1. Includes
calibration certificate.
Premium Calibration to ISO17025
S331E-0099 |S332E-0099 |S361E-0099 |S362E-0099 "C";ﬁb‘r\a'\:i'rﬁ'\'cgrst; giotgst'?gg‘:rfs
and uncertainty data.
S331E-0413 |S332E-0413 [S361E-0413 [S362E-0413 |Ethernet Connectivity
S332E-0431 S362E-0431 |Coverage Mapping®
S332E-0444 S362E-0444 |CMF Measurements (requires
Anritsu Isotropic Antenna)
S332E-0509 S362E-0509 |AM/FM/PM Analyzer

Site Master User Guide
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1-3 Calibration and Verification General Information

Table 1-2. Available Options

S331E S332E S361E S362E Description

CPRI LTE RF Measurements
(requires Option 759)

OBSAI LTE RF Measurements
(requires Option 759)

RF over Fiber Hardware (requires
Option 752 or 753)

S331E-0752 |S332E-0752 |S361E-0752 |S362E-0752

S331E-0753 |S332E-0753 [S361E-0753 |S362E-0753

S331E-0759 |S332E-0759 |S361E-0759 |S362E-0759

1. Requires External Power Sensor.
2. Requires Option 31.

1-3  Calibration and Verification

Anritsu recommends annual calibration and performance verification by local Anritsu
service centers. The Cable and Antenna Analyzer mode requires calibration standards for
OPEN, SHORT, and LOAD (OSL) or InstaCal module, which are sold separately.

Anritsu recommends allowing the instrument to warm up to typical operation

Note temperature (approximately 15 minutes) before calibrating.

The Site Master is self-calibrating and there are no field-adjustable components. The OSL
calibration components are crucial to the integrity of the calibration. As a result, they must be
verified periodically to ensure performance conformity. This is especially important if the
OSL calibration components have been accidentally dropped or over-torqued. Contact
information for Anritsu Service Centers is available at anritsu.com/contact-us.

14 Instrument Care and Preventive Maintenance

Instrument care and preventive maintenance consist of cleaning the unit and inspecting and
cleaning the RF connectors and all accessories. Clean the instrument with a soft, lint-free
cloth dampened with water or water and a mild cleaning solution.

Caution  To avoid damaging the display or case, do not use solvents or abrasive cleaners.

Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the
N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether
the connectors are undamaged, gauge the connectors to confirm that the dimensions are
correct. Visually inspect the test port cable(s). The test port cable should be uniform in
appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the
Type-N connectors. The recommended torque is 12 1bf ‘in to 15 1bf -in (1.36 N ‘m to 1.70 N ‘m).
Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can
damage the cable, the connector, the instrument, or all of these items.

1-4 PN: 10580-00252 Rev. W Site Master User Guide
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General Information 1-4 Instrument Care and Preventive Maintenance

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or
connector rings. Repair or replace damaged connectors immediately. Dirty connectors can
limit the accuracy of your measurements. Damaged connectors can harm the instrument.
Connection of cables carrying an electrostatic potential, excess power, or excess voltage can
damage the connector, the instrument, or both.

Connecting Procedure

1. Carefully align the connectors. The male connector center pin must slip concentrically
into the contact fingers of the female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight
resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or
45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order
to assure consistent torque. Use an open-end wrench to keep the connector body from
turning while tightening with the torque wrench.

Do not over-torque the connector.

Disconnecting Procedure

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning
while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.

ESD Caution

The Site Master, like other high performance instruments, is susceptible to electrostatic
discharge (ESD) damage. Coaxial cables and antennas often build up a static charge, which
(if allowed to discharge by connecting directly to the instrument without discharging the
static charge) may damage the Site Master input circuitry. Instrument operators must be
aware of the potential for ESD damage and take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices,
equipment, and practices. Because these apply to the Site Master, it is recommended that any
static charges that may be present be dissipated before connecting coaxial cables or antennas
to the Site Master. This may be as simple as temporarily attaching a short or load device to
the cable or antenna prior to attaching to the Site Master. It is important to remember that
the operator may also carry a static charge that can cause damage. Following the practices
outlined in the above standards will ensure a safe environment for both personnel and
equipment.

Site Master User Guide PN: 10580-00252 Rev. W 1-5



1-4 Instrument Care and Preventive Maintenance General Information

RF Input Warning

The Anritsu Site Master is a sensitive measuring instrument designed to measure low power
levels. Avoid damaging this sensitive circuitry by observing the maximum input levels
printed on the instrument connector labeling and specified in the product technical data
sheet.

Typical maximum input is +33 dBm (50 VDC) and could be less if additional features, such
as a preamplifier, are in use. Be sure to review the product technical data sheet or Anritsu
website for recommended components and accessories that can help you protect your
instrument. These include a variety of adapters, attenuators, filters, and RF detection
accessories.

Battery Replacement

The battery can be replaced without the use of tools. The battery compartment is located on
the lower left side of the instrument (when you are facing the measurement display). To
remove the battery:

Slide the catch toward the bottom of the instrument.
Pull the top of the door away from the unit.
Lift out the battery door.

Lol S

Remove the battery pack from the instrument by grabbing the battery lanyard and
pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) should
be facing the front of the unit and slide in first.

When inserting the battery, the battery label should face the back of the instrument
Note and the guide slot on the battery should be below the contacts. If the battery door
does not latch closed, the battery may be inserted incorrectly.

1-6 PN: 10580-00252 Rev. W Site Master User Guide



General Information 1-4 Instrument Care and Preventive Maintenance

Figure 1-1.

Battery Compartment

The battery that is supplied with the Site Master may need charging before use. The battery
can be charged while it is installed in the Site Master by using the AC-DC Adapter, or outside
the Site Master with the optional Dual Battery Charger. Refer to “Symbols and Indicators”
on page 2-9 for a description of battery symbols.

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this
instrument. Anritsu recommends removing the battery for long-term storage of the
instrument.

To ensure an improved battery life, do not charge the battery above 40°C.
Press Shift+8 > Status to view the Battery Temperature in the Status window.

If the battery temperature exceeds the limit, disconnect the AC power supply and
allow it to cool down and perform a power cycle before resuming operation.

Caution

When using the Automotive Power Adapter, always verify that the supply is rated
for a minimum of 60 Watts at 12 VDC, and that the socket is clear of any dirt or
debris. If the adapter plug becomes hot to the touch during operation, discontinue
use immediately.

Site Master User Guide PN: 10580-00252 Rev. W 1-7



1-5 Secure Environment Workplace General Information

1-5 Secure Environment Workplace

This section details the types of memory in the Site Master, how to delete stored user files in
internal memory, and recommended usage in a secure environment workplace.

Site Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM
memory. The instrument does not have a hard disk drive or any other type of volatile or
non-volatile memory.

Disk-On-A-Chip (DOC): DOC is used for storage of instrument firmware, factory calibration
information, user measurements, setups, and .jpg screen images. User information stored on
the DOC is erased by the master reset process described below.

EEPROM: This memory stores the model number, serial number, and calibration data for the
instrument. Also stored here are the user-set operating parameters such as frequency range.
During the master reset process, all operating parameters stored in the EEPROM are set to
standard factory default values.

RAM Memory: This is volatile memory used to store parameters needed for the normal
operation of the instrument along with current measurements. This memory is reset
whenever the instrument is restarted.

External USB Memory Device (not included with the instrument): This memory may be
selected as the destination for saved measurements and setups for the instrument. The user
can also copy the contents of the internal disk-on-chip memory to the external flash memory
for storage or data transfer. The external Flash USB can be reformatted or sanitized using
software on a PC.

Refer to Chapter 4, “File Management” for additional information on saving and copying files
to the USB memory device.
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Erase All User Files in Internal Memory

Perform a Master Reset:

1.

2
3.
4

Turn the instrument on.

Press the Shift button, then the System (8) button.
Press the System Options submenu key.

Press the Reset key, then the Master Reset key.

A message box will be displayed to warn the user that all settings will be returned to
factory default values and all user files will be deleted. This is a standard file deletion
and does not involve overwriting existing information.

Press the ENTER button to complete the master reset.

The instrument will reboot and the reset is complete.

Recommended Usage in a Secure Environment

Set the Site Master to save files to the external USB memory device:

1.
2
3.
4

5.

Attach the external Flash drive and turn the instrument on.
Press the Shift button, then the File (7) button.
Press the Save submenu key.

Press the Change Save Location submenu key, then select the USB drive with the
rotary knob, Up/Down arrow keys, or the touch screen.

Press the Set Location submenu key.

The external USB drive is now the default location for saving files.

Not all USB drives are compatible with the instrument. Many drives come with a
second partition that contains proprietary firmware. This partition must be

Note removed. Only one partition is allowed. Refer to the individual manufacturer for

instructions on how to remove it. Some drives can be made to work by reformatting
them using the FAT32 format.

Site Master User Guide PN: 10580-00252 Rev. W 1-9



1-5 Secure Environment Workplace General Information

1-10 PN: 10580-00252 Rev. W Site Master User Guide



Chapter 2 — Instrument Overview

2-1 Introduction

This chapter provides an overview of the Anritsu Site Master. It describes the instrument
front panel, touch screen display, and the connector panel. For detailed information on the
instrument’s test and measurement functions, refer to one of the Anritsu user documents
listed in Appendix A, “Measurement Guides”.

2-2  Turning On the Site Master

The Anritsu Site Master S331E/S361E models are capable of approximately four hours and
the S332E/S362E models are capable of approximately three hours of continuous operation
from a fully charged, field-replaceable battery (refer to “Battery Replacement” on page 1-6).

The Site Master can also be operated from a 12 VDC source (which will simultaneously
charge the battery). This can be achieved with either the Anritsu AC-DC Adapter or the
Automotive Power Adapter. Both items are included as standard accessories with the Site
Master. Refer to the instrument Technical Data Sheet.

When using the Automotive Power Adapter, always verify that the supply is rated
for a minimum of 60 Watts @ 12 VDC, and that the socket is clear of any dirt or
debris. If the adapter plug becomes hot to the touch during operation, discontinue
use immediately.

Caution

To turn on the Site Master, press the green On/Off button on the front panel (see Figure 2-1
on page 2-2).

The Site Master takes approximately 60 seconds to complete power-up and to load the
application software. At the completion of this process, the instrument is ready for use.

Keep the fan inlet and exhaust ports clear of obstructions at all times for proper

Note ventilation and cooling of the instrument.

Site Master User Guide PN: 10580-00252 Rev. W 2-1



2-3 Instrument Front Panel Instrument Overview

2-3 Instrument Front Panel

The Site Master uses a touch screen and keypad for data input. See Figure 2-1. The five
bottom menu keys and up to eight submenu keys on the right side of the display are touch
screen keys. The menu and submenu keys vary depending on the current operation mode and
instrument function selected. Refer to “Mode Selector” on page 2-16.

Fan Exhaust Fan Inlet Port

Port { /
Calibration . Touch Screen
Status and Type Submenu Keys

N
L

“\ \‘H ‘I\‘““\w “‘f“““‘l‘"\‘ M1
mw i i siﬂﬁ/smﬂ -

At \r \ h

‘(‘

I

M i Menu Key

|
,1 I ”“”

Numeric Keypad/
Shift Menu Keys (1 to 9)
Printed in Blue

aaaaa

‘i T—‘ Fan Inlet Port

Touch Screen On/Off Button
Main Menu Keys

Figure 2-1. Site Master Front Panel and Interface Screen

LED Indicators

Power LED

The Power LED is located on the left of the On/Off button. The LED is solid green when the
instrument is on, and blinks slowly when the unit is off but is connected to an external power
source.

Charge LED

The Charge LED is located on the right of the On/Off button. The LED blinks slowly when the
battery is charging and is solid green when the battery is fully charged.
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Instrument Overview 2-3 Instrument Front Panel

Front Panel Keys

The numeric keypad, rotary knob, and the four arrow keys can all be used to change the value
of the currently selected parameter.

Numeric Keypad

Keys 0 through 9 are used for numeric input, with an alternate function printed in blue above
each of the keys. Press the Shift key, then a numeric key, to access the instrument menu or
function indicated by the key label.

Some of the alternate functions associated with the numeric keypad are not available in all
measurement modes. Refer to the Measurement Guides listed in Appendix A, “Measurement
Guides”.

Shift Key

Pressing the Shift key followed by a number key executes the function that is indicated in
blue above the number key. When the Shift key is active, its icon is displayed at the far right
of the title bar, above the sweep window.

| Anritsu enozos sadosopn @ e Earwizrarar B G [ @
Figure 2-2. Shift Key Icon in Title Bar

Esc Key

Press this key to cancel the parameter change being made and exit the current menu
function, if applicable.

Arrow Keys

The four arrow keys are used to scroll through a list and highlight the item you wish to select,
or to change the value of the currently selected parameter. The arrow keys can also be used to
move markers. The rotary knob performs similar functions.

Enter Key

Press this key to apply a parameter value or instrument setting you have entered, or to select
a highlighted item from a list.

Rotary Knob

Turn the rotary knob to change numerical values, scroll through selectable items in a list, or
to move markers. Values or items may be within a dialog box or an edit window.
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Menu Key

The Menu key displays a grid of shortcut icons for installed measurement modes and
user-selected menus and setup files. See Figure 2-3. Press one of the icons in the top rows to
switch to the corresponding application. These icons are system-generated and cannot be
moved or deleted.

An alternative to the Menu key is to press Shift, then the Mode (9) key to display the Mode
Selector list box. Refer to “Mode Selector” on page 2-16.

Figure 2-3. Menu Key Screen

Shortcut icons displayed in the top rows of the Menu screen vary with the
Note instrument model, firmware version, and installed options. Help for the Menu
screen is available by pressing the icon in the lower-right corner of the display.
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User-Created Shortcuts

To create a shortcut to any submenu key or main menu key, press and hold the key until a
grid appears, showing the open locations on the Menu screen where you can place the new
shortcut. Press one of the cells in the displayed grid to place the shortcut. See Figure 2-4.

| Anritsu vrnarors s0aar pn El D [

Figure 2-4. Placement Grid for User-Created Shortcuts

To create a shortcut to a setup file (.stp), press Recall under the File menu, then press and
hold the desired file name until a grid is displayed. Select the display location of the new
shortcut as described above.

User-defined shortcuts remain on the Menu screen until deleted. To delete or move a shortcut
icon, press the Menu key, then press and hold the shortcut until the Customize Button dialog
appears. See Figure 2-5. Press the appropriate button to delete or move the shortcut icon.

Customize Button

Delete Selected Ican Switch Icon Location

Figure 2-5. Customize Button Dialog

Press Esc to close the dialog without deleting or moving the shortcut. Also use Esc to exit the
Menu screen.
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Interface Screen

Instrument Overview

2-4

Interface Screen

Figure 2-6 and Figure 2-7 illustrate the Site Master interface screen in Cable and Antenna
mode and Spectrum Analyzer mode, with touch screen menu keys, title bar, and
measurement settings and results around the graph area, or sweep window.

N

CDMA US PCS - UpLink plus D

@~
@O

Ref Freq Ref Ampl

Freg/Dist

|/]n|‘itSLI\Q1 w2015 0423 pn GED Narsas wizaver e @8

Measurements
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Marker
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Marker
To
Peak
Marker
To
Valley
Peak/valley
Auto
Marker Table
On off
All Markers

off

Marker

Figure 2-6. Cable and Antenna Analyzer Return Loss Measurement Display
1. Measurement Settings Summary
2. Calibration Status, Type
3. Frequency Standard
4. Date and Time
5. GPS Icon
6. GPS Location
7. Save Icon
8. Save Screen Icon
9. Battery Charge Indicator
10. | Trace Measurement Title
11. | Submenu Touch Screen Keys
12. | Main Menu Touch Screen Keys
13. | Marker Table
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Figure 2-7. Spectrum Analyzer Display (S332E and S362E only)

Measurement Settings Summary (Touch Screen Shortcuts)
Frequency Standard

Date and Time
GPS Icon
GPS Location
Save Icon

Save Screen Icon

OINIoO| ORI =

Battery Charge Indicator

©

Trace Measurement Title

—
©

Submenu Touch Screen Keys

—_
—_

Main Menu Touch Screen Keys
Marker Table

—
N

Many of the measurement settings displayed to the left and the top of the sweep
Note window are actually touch screen shortcuts that you can press to bring up the
corresponding menu.
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Touch Screen Keys

Main Menu Touch Screen Keys

There are five main menu keys horizontally arranged along the bottom of the interface
screen. These keys give access to the instrument’s test and measurement functions, which are
documented in the applicable Measurement Guide. Refer to Appendix A, “Measurement
Guides”.

Different operation or measurement modes may display different main menu keys. To switch
to another mode, press the Menu key, or press Shift followed by the Mode (9) key.

The instrument model and installed options determine what measurement modes

Note are available. Refer to Table 1-1 on page 1-3 and Table 1-2 on page 1-3.

Submenu Touch Screen Keys

Most of the instrument setup, control, and measurement functions are performed through the
use of the submenu keys along the right side of the display. The key labels change as
measurement settings and instrument setup parameters change. The current submenu title
is displayed at the top of the submenu key block, which consists of up to eight touch screen
keys. See Figure 2-6 on page 2-6.

Symbols and Icons on the Title Bar

Iflnritsu 0BA0/2015 034050 pm G Nam e 4T wiziesr 2 b= GE [ G
Figure 2-8. Title Bar with Icons

The instrument title bar displays the system date and time. When GPS is on and is tracking
satellites, its icon is followed by latitude and longitude coordinates.

Press the storage icon to open the touch screen keyboard for saving measurements, setups,
limit lines, or screen display JPEG files. This shortcut to the “Save Menu” on page 4-11 is
equivalent to pressing Shift and File (7), then Save. Refer to “Save Dialog Box” on page 4-3.

Press the camera icon to save a JPEG image of the current screen display.

The battery symbol indicates the charge remaining in the battery. The colored section inside
the symbol changes size and color with the charge level. The Battery Charge LED (adjacent to
the On/Off button) flashes when the battery is charging, and remains on steady when the
battery is fully charged.

Use only Anritsu-approved batteries, adapters, and chargers with this instrument.
Caution  Anritsu Company recommends removing the battery for long-term storage of the
instrument.

The Shift icon is displayed after the Shift key is pressed, and it remains displayed until
another button is pressed.
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2-4 Interface Screen

Symbols and Indicators

The following symbols, icons, and indicators convey the instrument status or condition on the
display. The colors shown here are in the standard or default display mode.

Table 2-1. Symbols and Icons

Symbol

Description

Green: Battery is 30% to 100% charged.

Yellow: Battery is 10% to 30% charged.

Red: Battery is 0% to 10% charged.

Green with Black Plug body: Battery is fully charged and
external power is applied.

Lightning Bolt: Battery is being charged (any color symbol).

Red Plug body: External power is applied, and no battery is
installed, or battery has lost communications with the instrument.

Storage Icon: Tap the floppy disk icon to display the Save screen
and menu.

Camera Icon: Saves a JPEG image of the current screen display.

fe=-1 ]

Shift Key Icon: This icon is displayed between the battery symbol
and the submenu keys after the Shift key has been pressed, and
until another key is pressed.

S

D

GPS Icon: This icon is displayed right after the date and time
when GPS is available. Refer to Chapter 6, “GPS (Option 31) ” for
details.

Power@ @ Charge

¢

Power Button with Power LED and Charge LED: This is a
physical button with LED indicators. It is located near the numeric
keypad.
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Display Settings

The Display Settings submenu lets you adjust the screen brightness level and control the
auto-dimming function. Refer to “Brightness Settings Menu” on page 5-8.

You can also turn off the display entirely, as described in “Display Settings Menu”
on page 5-7. To turn the display back on, press any key (except the Power button) three times
in rapid succession.

In addition to the default display colors shown in Figure 2-7 on page 2-7, you can select
different color schemes to suit the ambient lighting conditions. See Figure 2-9. Some color
settings may not be available in all measurement modes.

Black on White — used for printing and viewing in broad daylight conditions
Night Vision — optimized for nighttime viewing
High Contrast — used in challenging viewing conditions

Color on White — used for printing and viewing in broad daylight conditions
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Figure 2-9. Site Master Display Color Settings
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Touch Screen Calibration

Calibration optimizes the response of touch input. It is recommended if the instrument does
not respond as expected when you press the touch screen.

The Calibrate Touch Screen submenu key is in the “System Menu” on page 5-3. When pressed,
a message box is displayed with instructions for calibration. See Figure 2-10. Press Enter to
begin calibration, or press Esc to cancel. Alternatively, you can press 1 while the message box
is displayed to use the arrow keys for navigation. Refer to “Disable Touch Screen to Use
Arrow Navigation”.

TOUCHSCREEM CALIBRATION

The touchscreen calibration optimizes the response of touch inputs

Itis recommended o perform the calibration it your touch inputs do not correspond to
the appropriate location an the screen. It reguires you 1o tap a target on the scraen
Press ENTER 1o Start touchscreen Calibration

Press ESCAPE to Cancel

Press 110 go to arrow navigation

Figure 2-10. Touch Screen Calibration Message Box

During calibration, press the crosshairs in sequence as they appear on the screen. The
process takes less than one minute.

Calibrate Touch Screen Shortcut

Another way to access touch screen calibration is to press Shift, then 0 (zero). This displays
the touch screen calibration message box shown in Figure 2-11. The shortcut can be used if
your touch inputs do not correspond to the appropriate locations on the screen to such an
extent that you cannot access the Calibrate Touch Screen submenu key.

Disable Touch Screen to Use Arrow Navigation

If the touch screen is not functioning, you can use Arrow Navigation to simulate pressing the
touch screen main menu keys and submenu keys. From the touch screen calibration message
box (see Figure 2-10), press 1 to display the arrow navigation message box, illustrated in
Figure 2-11. Press 1 again to enter the arrow navigation mode, or press Esc to cancel.

ARROW MAVIGATION

Arrove Mavigation mode enahles you to navigate the menus withaut a tauchscreen
In Arrow Mavigation Mode

Use the Arrow keys to move the red selection box

Press the MENL key to activate the selected button

Reboot the instrument to return to narmal touch entry mode

Press 1 to enter the arow navigation mode

Press ESCAPE to Cancel

Figure 2-11. Arrow Navigation Message Box

In arrow navigation mode, a red border highlights the currently selected key (see Figure 2-12
on page 2-12). Use the arrow keys to move the red selection box, then press the Menu key to
activate the highlighted key. Only the main menu keys and submenu keys can be activated
using Arrow Navigation. This feature does not move the red selection box into other areas of

the touch screen, like the display title bar, sweep window, or the instrument settings area on
the left.
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To save a measurement in arrow navigation mode, press Shift then File (7). Use the arrow
keys to move the red selection box to the Save Measurement As submenu key. This submenu
key must be used because the arrow navigation mode cannot be used to change data in popup
windows in the measurement display. File names are determined by the current setting of the
Save Measurement As submenu key. Refer to “Save Measurement As” on page 4-10.

You can save a JPEG image of the current display screen by pressing Shift, followed by
Decimal, then +/—. The JEPG image shows screen data, but does not contain the additional

measurement information that accompanies a saved measurement in a *.spa measurement
file.

To return to normal touch entry mode, reboot the instrument (turn power Off, then On). If
your touch screen has been damaged, refer to “Contacting Anritsu for Sales and Service”
on page 1-2.
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Figure 2-12. Arrow Navigation Example
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Calibration Symbols

The current calibration status and type is displayed in the upper-left of the screen when in
Cable & Antenna Analyzer mode. See Figure 2-6 on page 2-6. The five status messages are
described next.

Cal Status: ON, Flex

The Site Master has been calibrated with discrete Open, Short, and Load components. This is
a FlexCal calibration indicating it is possible to change the frequency range after calibration.

Cal Status: ON, Standard

The Site Master has been calibrated with discrete Open, Short, and Load components. This is
a Standard calibration indicating it is not possible to change the frequency range after
calibration without performing another calibration.

Cal Status: ON, Flex, Insta

The Site Master has been calibrated with the InstaCal module. This is a FlexCal calibration
indicating it is possible to change the frequency range after calibration.

Cal Status: ON, Standard, Insta

The Site Master has been calibrated with the InstaCal module. The Site Master has been
calibrated with discrete Open, Short, and Load components. This is a Standard calibration
indicating it is not possible to change the frequency range after calibration without
performing another calibration.

Cal Status Off:
The Site Master has not been calibrated.

For calibration procedures, refer to the Cable & Antenna Measurement Guide listed in
Appendix A, “Measurement Guides”.
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2-5 Data Entry

User input can be in the form of numeric values for instrument or measurement settings,
selected values from a preset list, or alphanumeric text when entering file names, for
example. To view or change a parameter value, access the appropriate submenu by pressing
one of the five main menu keys along the bottom of the interface screen, then navigating
through the touch screen submenus.

Other instrument functions are accessible from the numeric keypad, when used in
combination with the Shift key. Refer to “Numeric Keypad” on page 2-3. Some of the
parameter settings displayed on the left of the interface screen or under the title bar are
touch screen shortcuts to related submenus.

Depending on the measurement mode, refer to the associated Measurement Guide listed in
Appendix A, “Measurement Guides” for a description of available menus and submenus.

Numeric Values

To modify a numeric parameter setting that is displayed on a submenu touch screen key,
press the key to make it active. The display color of the currently set value changes to red.
Use the rotary knob, arrow keys, or the numeric keypad to change the value. When entering a
value from the keypad, the submenu typically shows the selectable units. Press the desired
unit or press Enter to complete the entry.

Selection Lists

Some parameters and instrument functions are selectable from a pop-up list. These list boxes
display the available selections, and value limits if applicable. Use the arrow keys or the
rotary knob to scroll through the list and highlight the desired entry. You can also use the
touch screen to make your selection.

To apply the selection, press Enter. To exit the selection list without making a change, press
the Escape (Esc) key.
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Text Entry

When an instrument function requires you to enter text, such as a name for a measurement
or setup file you wish to save, a touch screen keyboard is displayed. See Figure 2-13. Digits
can be entered using the touch screen keyboard or the front panel keypad. The left and right
arrow keys move the insertion point in the file name edit box.

Refer to “Save Dialog Box” on page 4-3 for information on saving files.

Location: /nternal kemary

Filename: |F”EN3'”E

Filetype: | Measurement = I Free Space: 1.5 GB

Space

Cuick Mame 1 Gluick Name 2 Gilick Mame 3 Gluick MName 4 Giuick Mame 5

Figure 2-13. Touch Screen Keyboard
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2-6 Mode Selector

To change to another operation or measurement mode, press Shift, then the Mode (9) key to
display the Mode Selector list box, illustrated in Figure 2-14. Use the directional arrow keys
or the rotary knob to highlight the desired mode, then press Enter to switch to the selected
application. The measurement modes available for selection depend on the options that are
installed and activated on your instrument.

An alternate method of selecting a measurement mode is through the use of the “Menu Key”
on page 2-4.

Cabl \ntenna & er
Transmission keasurement
Spectrum Analyzer

Power Meter

High accuracy Power heter
Interference &nalyzer
Channel Scanner

CW Signal Generator
AM-FM-PM Analyzer

PIM Analyzer

CPRI Mode

COBSAl Mode

Figure 2-14. Mode Selector List Box
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2-7 Connector Panel

The Site Master S332E connector panel is illustrated in Figure 2-15.

Figure 2-15. S332E Connector Panel

External Reference In

External Trigger In

Analyzer/RF In (Type N)

GPS Type SMA (Option 31)

USB Mini-B

RJ45 Ethernet Connector (Option 413)
External Power

USB Type A

Headset jack

SFP Optical Module Connector (Option 759)
RF Out (Type N)

2 S|e| XN gl wIN =

=1 O

External Reference In

The External Reference In port is a 50 Q BNC female connector that provides for input of an
external frequency reference. Refer to your Technical Data Sheet for valid frequencies. To
prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC
connector.
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External Trigger In (S332E, S362E Models)

A TTL signal that is applied to the External Trigger female BNC input connector causes a
single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering
occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is
displayed until the next trigger signal arrives.

Analyzer/RF In
This is a 50 Q Type-N female connector. The maximum input is +33 dBm at +50 VDC.

USB Interface — Mini-B

The USB 2.0 Mini-B connector can be used to connect the Site Master directly to a PC. The
first time the Site Master is connected to a PC, the normal USB device detection by the
computer operating system will take place.

For proper detection, the applicable Anritsu Software Tool should be installed on

Note the PC prior to connecting the Site Master to the USB port.

GPS Antenna Connector (Option 31)

The GPS antenna connection on the Site Master is type SMA-female. GPS function is
described in Chapter 6, “GPS (Option 31) ”.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the
SMA connector. Do not over-tighten the connector. The recommended torque is 8 Ibf ‘in
(0.9 N ‘'m or 90 N ‘cm).

External Power

This is a 2.1 mm by 5.5 mm barrel connector, 12.5 to 15 VDC, < 4.0 A. The external power
connector is used to power the unit and for battery charging. A green blinking LED near the
Power button indicates that the instrument battery is being charged by the external charging
unit. The indicator is a steady green when the battery is fully charged.

When using the AC-DC Adapter, always use a three-wire power cable that is
connected to a three-wire power line outlet. If power is supplied without grounding
the equipment in this manner, then the user is at risk of receiving a severe or fatal
electric shock.

Warning

Refer to “External Power On” on page 3-11 and “Power-On Menu” on page 5-6 when
controlling the Site Master via external power.

USB Interface — Type A
The Site Master has two Type A USB connectors that accept USB Flash Memory devices for
storing measurements, setup data, and screen images.

Headset Jack

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing
and troubleshooting wireless communication systems. The jack accepts a 2.5 mm 3-wire
miniature phone plug such as those commonly used with cellular telephones.

2-18 PN: 10580-00252 Rev. W Site Master User Guide



Instrument Overview 2-7 Connector Panel

LAN Connection (Option 413)

The RJ-45 connector is used to connect the Site Master to a local area network or directly to a
PC with an Ethernet crossover cable. Integrated into this connector are two LEDs. The amber
LED shows the presence of a 10 Mbit/s LAN connection when on, and a 100 Mbit/s LAN
connection when off. The green LED flashes to show that LAN traffic is present. For more
information on the LAN connection, Ethernet connection, and DHCP, refer to Chapter 9 and
Appendix B.

Optical SFP (Option 759)

The optical transceiver port is used to connect the instrument to the fiber optic CPRI or
OBSALI link between a Radio Frequency Module (RFM) and a Base Band Module (BBM). This
SFP port is present only when Option 759 (RF over Fiber hardware) is installed. Refer to the
instrument’s Technical Data Sheet for transceiver part numbers and specifications.

Option 759 requires either Option 752 (CPRI LTE RF Measurements) or
Note Option 753 (OBSAI LTE RF Measurements). The combination of Option 759 and
Option 752 is functionally identical to obsolete Option 751.

RF Out (Reflection In)

RF output, 50 Q Type-N female connector, for reflection measurements. The maximum input
is +23 dBm at +£50 VDC.
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2-8 Soft Carrying Case
The Site Master can be operated while in the soft carrying case. On the back of the case is a

large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:
The front panel of the case is secured with hook-and-loop fasteners. Fully close the

1.
front panel of the case. When closed, the front panel supports the shape of the case
while you are inserting the Site Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully

closed and laying flat.

The soft case has two zippers near the back. The zipper closer to the front of the
case opens to install and remove the instrument. The zipper closer to the back of
the case opens an adjustable support panel that can be used to provide support for
improved stability and air flow while the instrument is in the case. This support

panel also contains the storage pouch.

Note

Open the zippered back of the case.

Insert the instrument face down into the case, take care that the connectors are
properly situated in the case top opening. You may find it easier to insert the
connectors first, then pull the corners over the bottom of the Site Master.

)]

L
S
N
=
;

Figure 2-16. Instrument Inserted into the Soft Carrying Case

5. Close the back panel and zipper to secure the Site Master.
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Instrument Overview 2-9 Tilt Bail Stand

The soft carrying case includes a detachable shoulder strap, which can be connected to the
D-rings of the case.

The soft case has panel openings for the fan inlet and exhaust ports. Do not block

Caution the air flow through the panels when the unit is operating.

2-9 Tilt Bail Stand

A Tilt Bail is attached to the back of the Site Master for desktop operation. The tilt bail
provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the
bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the
bottom of the bail towards the back of the instrument until it attaches to the Site Master.

Do not use the tilt bail while the instrument is in the soft case. The soft case has an

Note adjustable support panel in the back zipper.

Figure 2-17. Tilt Bail Extended
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Chapter 3 — Quick Start Guide

3-1 Introduction

This chapter provides a brief overview of basic setups for the following measurement modes:
e “Cable & Antenna Analyzer” on page 3-2
e “Spectrum Analyzer” on page 3-7

For detailed descriptions of measurement functions and settings, refer to the appropriate
Measurement Guide as listed in Appendix A, “Measurement Guides”.

3-2 Measurement Mode Selection

Press the Menu key, then press the shortcut icon for the desired application, or measurement
mode. See Figure 3-1. Alternatively, you can press Shift followed by the Mode (9) key, then
select the measurement mode from the Mode Selector list box.

anne|
oy

CPRIRF 0BSAl RF

Figure 3-1. Menu Key Screen

The application shortcuts displayed in the top rows of the Menu screen will vary

Note depending on the firmware and options installed on the instrument.
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3-3 Cable & Antenna Analyzer

Set the instrument to Cable & Antenna Analyzer mode as described in the previous section.

Select the Measurement Type

Press the Measurement main menu key and select the appropriate measurement.

|Anritsu 07/30/2015 01:04:52 pm = 7 Measurement 1/2

Return Loss

Cahle Loss

DTF

Return Loss
DTF ¥SWR

Display Format
| Single Dual
Active Display

Top Buottom

Freog/Dist Amplitude Sweep/Setup | Measurements harker

Figure 3-2. Measurement Screen

Set the Frequency
1. Press the Freq/Dist main menu key.

2. Press the Start Freq submenu key and use the keypad, rotary knob, or the arrow keys to
enter the start frequency.

3. Press the Stop Freq submenu key and use the keypad, rotary knob, or the arrow keys to
enter the stop frequency.

Set the Amplitude
1. Press the Amplitude main menu key.

2. Press the Top submenu key and use the keypad, rotary knob, or the arrow keys to edit
the top scale value. Press Enter to set.
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3. Press the Bottom submenu key and use the keypad, rotary knob, or the arrow keys to
edit the bottom scale value. Press Enter to set.

For Amplitude in Smith Chart measurements, refer to “Smith Chart” on page 2-23
Note of the Cable & Antenna Measurement Guide listed in Appendix A, “Measurement
Guides”.

Turn on Markers
1. Press the Marker main menu key.

2. Press the Marker 12 34 5 6 submenu key and select the marker number 1 button using
the touch screen. The underlined number on the Marker submenu key indicates the
active marker.

3. Use the arrow keys, the keypad, or the rotary knob to move the marker. The current
value for the selected marker is shown above the upper-left corner of the graph. It is
also possible to drag the marker using the touch screen.

4. Delta Markers are available for each of the six reference markers. For the selected
marker, Toggle the Delta On/Off submenu key to turn on the Delta marker.

Peak/Valley Auto Markers

When making Return Loss and VSWR measurements, the Peak/Valley Auto feature can be
used to automatically turn on Marker 1 to peak, Marker 2 to valley, and display M1 and M2
in the Marker Table. This feature is not available for DTF measurements.

1. Press the Marker main menu key.
2. Press the Peak/Valley Auto key.
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Single Limit Line
1. Press Shift, then Limit (6) to display the Limit menu.
2. Press the Limit On/Off key to turn on the Limit.

3. Press Single Limit and then use the numeric keypad, the arrow keys, or the rotary knob
to change the limit value and then press Enter.

Refer to the Cable & Antenna Measurement Guide listed in

Note Appendix A, “Measurement Guides” for creating multi-segment limit lines.

4. Press the Limit Alarm key to turn on or off the Limit Alarm.

E =& m Limit

L e -

\ =5
— N i -

L
1.067 5 Warning Limit Offset

|Anritsu 02/18/2016 11:03:30 am

Cal Siatus
[« o

Pass Fail Message
‘ an off

Pass/Fail

Unbounded Bounded

0.0 dB

Clear Limit

o 2.000 MHz

Freg/Dist Amplitude Sweep/Setup Measurements Marker

Figure 3-3. Single Limit Lines
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DTF Setup
1. Press the Measurements main menu key and select DTF Return Loss or DTF VSWR.
2. Press the Freq/Dist main menu key.

3. Press the Units submenu key and select m to display distance in meters or ft to display
distance in feet.

4. Press DTF Aid and use the touch screen or arrow keys to navigate through all the DTF
parameters.

a. Set Start Distance and Stop Distance. Stop Distance needs to be smaller than
Dmax.

b. Enter the Start and Stop frequencies.
Press Cable, select the appropriate cable from the cable list and press Enter.

Press Continue.

AINritsu oz18/2016 11:06:54 am E.] (7] \ DTF Aid
DTF Parameters o

Start Distance (m):
Stop Distance (m): [ 548 onex-semm
Start Frequency (MHz): [ 2000

Stop Frequency (MHz): [ 6000.000 (auitres = 00om)

Data Points: 275
Cable: NONE

Propagation Velocity: 0.800

Start Cal

ik

Cable Loss (dB/m): 0.006

| Continue |

Freg/Dist I Amplitude I Sweep/Setup I Measurements I Marker

Figure 3-4. DTF Aid

5. Press Shift, then Calibrate (2) to calibrate the instrument. Refer to “Calibrate with OSL
Calibration” on page 3-6 for additional information.

6. Press the Marker main menu key and set the appropriate markers.
Press Shift and Limit (6) to enter and set the appropriate limit lines.

Press Shift and File (7) to save the measurement. See the User Guide for details.
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Calibrate with OSL Calibration

Refer to the Cable & Antenna Measurement Guide listed in

Note Appendix A, “Measurement Guides” for calibration details.

Press the Freq/Dist main menu key and enter the appropriate frequency range.
Press Shift, followed by Calibrate (2).

Select Standard or FlexCal.

Press Start Cal and follow instructions on screen.

Connect Open to RF Out and press the Enter key.

Connect Short to RF Out and press the Enter key.

Connect Load to RF Out and press the Enter key.

NS e ® e

Verify that the calibration has been properly performed by checking that the Cal Status
message 1s now displaying “ON, Standard” or “ON, FlexCal”.

[ oPeN]
CALIBRATION

o
2

RFOUT/REFLECTION TEST PORT CABLE (OPTIONAL)
TEST PORT

\

Anritsu - S362E SiteMaster 7'

Figure 3-5. Calibration Setup with OSL Cal
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3-4 Spectrum Analyzer

Set the instrument to Spectrum Analyzer mode as described in Section “For detailed
descriptions of measurement functions and settings, refer to the appropriate Measurement

Guide as listed in Appendix A, “Measurement Guides”.” on page 3-1.

Set Start and Stop Frequencies
1. Press the Freq main menu key.
2. Press the Start Freq submenu key.

3. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob.
When entering a frequency using the keypad, the submenu key labels change to GHz,
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same
affect as pressing the MHz submenu key.

4. Press the Stop Freq submenu key.
Enter the desired stop frequency.

Enter the Center Frequency
1. Press the Freq main menu key.
2. Press the Center Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary
knob. When entering a frequency using the keypad, the submenu key labels change to
GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the
same affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard
1. Press the Freq main menu key.
2. Press the Signal Standard submenu key. The Signal Standards dialog box opens.
3. Highlight a signal standard and press Enter to select.
4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Measurement Frequency Bandwidth
1. Press the BW main menu key to display the BW menu.

¢ Press the RBW and/or the VBW submenu key to manually change the values.

¢ Set RBW and VBW automatically by pressing the Auto RBW submenu key or the
Auto VBW submenu key.

2. Press the RBW/VBW submenu key to change the resolution bandwidth and video
bandwidth ratio.

3. Press the Span/RBW submenu key to change the span width to resolution bandwidth
ratio.
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Set the Amplitude

Press the Amplitude main menu key to display the Amplitude menu.

Set Amplitude Reference Level and Scale

1. Press the Reference Level submenu key and use the arrow keys, rotary knob, or the
keypad to change the reference level. Press Enter to set the reference level value.

2. Press the Scale submenu key and use the arrow keys, rotary knob, or the keypad to
enter the desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale

1. Press the Auto Atten submenu key to set an optimal reference level based on the
measured signal.

Press the Scale submenu key.

Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob.
Press Enter to set. The y-axis scale is automatically renumbered.

Power Offset Set Up for Compensating External Loss

To obtain accurate results, compensate for any external attenuation by using power offset.
In power offset mode, the compensation factor is in dB. (External attenuation can be created
by using an external cable or an external high power attenuator.)

Press the RL Offset submenu key and use the keypad, the arrow keys, or the rotary knob to
enter the desired offset value. When using the rotary knob, the value changes in increments
of 0.1 dB. Using the Left/Right arrow keys changes the value in 10% increments of the value
shown on the Scale submenu key. When using the Up/Down arrow keys, the value changes in
the increment shown on the Scale submenu key. When using the keypad, enter the new value
then press Enter or the dB submenu key to set the value. The power offset is displayed in the
instrument settings summary column on the left side of the measurement display.

Set the Span

1. Press the Span main menu key or the Freq main menu key followed by the
Span submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key.

To quickly move the span value up or down, press the Span Up 1-2-5 or Span
Note Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out feature in a
1-2-5 sequence.
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Single Limit Line
Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line,
Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is
underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first
Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the
dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Create a Limit Envelope
1. Press Shift, then Limit (6) to display the Limit menu.
2. Select Limit Envelope.
3. Press the Create Envelope key.

IAnritsu 02/18/2016 1241:22 pm H (7] Limit Envelope
S n &nalyzer

Ref Lvl Create Envelope
-G65.0 dEm

Input Atten Upper Points Per Envelope 20 Update
0.0 dB

Envelope Amplitude
Detection
Peak
.;ﬁ;‘

b

Upper Offset

= f\” b M{m \\ N. '\'h %, ln w ‘l W ’\ M‘ \M' Wil f”r\rm\ }m\ M e

Int Std Accy Back
ES000 Mz 7 AHz 750,000 MHz [P

Frag Amplitude Span BW Marker

Figure 3-6. Limit Envelope
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Setting Up Markers
Press the Marker main menu key to display the Marker menu.
Selecting, Activating, and Placing a Marker

1. Pressthe Marker 12 34 56 submenu key and select the desired marker using the touch
screen marker buttons. The selected marker is underlined on the Marker submenu key.

2. Press the On Off submenu key so that On is underlined. The selected marker is
displayed in red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.
4. Repeat steps 1 through 3 to activate and move additional markers.
Selecting, Activating, and Placing a Delta Marker

1. Press the Marker 1 2 34 5 6 submenu key and select the desired delta marker. The
selected marker is underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is
displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat steps 1 through 3 to activate and move additional markers.
Viewing Marker Data in a Table Format

1. Press the More submenu key.

2. Press the Marker Table On Off submenu key so that On is underlined. All marker and
delta marker data are displayed in a table under the measurement graph.

|Anritsu 02418/2016 12:57:25 pm Marker 172
B harker

Ref Lvi = e
-65.0 dBm 123456

Input Atten
0.0 dB

Detection
[MELS

RBW

p Time
700 ms Iarker Frag

Traces to

i

Peak

750.000 MHz

Options e—pm

harker

Figure 3-7. Marker Table
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Select a Measurement Type

In Spectrum Analyzer mode, press Shift, then Measure (4) and select a measurement using
the submenu keys.

[ Anritsu vz ozms 02 0336 = 2 Measure
Paower and

Ref Lvl _
-70.0 dEm Eandwmth_’

P Masks and
0.0de

Detection
Peak

Center 700
Span 1.0

Amplitude Marker

Figure 3-8. Spectrum Analyzer Measure Menu

External Power On

The When DC Applied setting in the Power-On menu allows the Site Master to restart
automatically when external DC power is applied to the connector shown in Figure 2-15
on page 2-17. Refer to “External Power” on page 2-18 and the “Power-On Menu” on page 5-6.

When this feature is enabled, the Site Master in the off state will turn on when external DC
power is applied. The instrument turns off when external power is removed, even if a battery
is installed. This is useful for high-reliability remote operation, where the instrument may
need to be rebooted using a remotely-controlled power switch.

If the instrument is turned on with the power switch, then external power is removed, the
instrument will continue to run until the battery is depleted. It will come on and the battery
will begin recharging when external power is applied. This state is useful when the
instrument is in a location where the power source may be interrupted.
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Chapter 4 — File Management

4-1 Introduction

This chapter describes the file management features of the Site Master and the related touch
screen menus. The File menu and its submenus allow you to save, recall, copy, and delete files
in internal memory or an external USB flash drive.

4-2 Managing Files
Press the Shift key, then the File (7) key on the numeric keypad to display the File menu.

When navigating through the File menu, press the Esc key to return to the
Note previous menu or submenu. Any changes not yet applied (by pressing Enter) are
canceled.

File Types

Under the Save, Recall, Copy, and Delete menus, press the Change Type or the File Type
submenu key to open the Select File Type list box, where you can select the desired file type.

Available file types depend on the current instrument mode. The Select File Type list box may
contain the following entries:

e ALL (displays all file types)

e Setup, *.stp
(Setup files contain basic instrument information, measurement mode setup details,
measurement marker data, and limit data.)

¢ Measurement, *.spa, *.dat, *.vna, *.ia, *.cs, *.edg, *.wcd, *.tds,
*.cdma, *.evdo, *.wmxd, *.wmxe, *.afp
(Measurement files contain all of the information in the setup files and the
measurement data. File extensions are determined by the current measurement mode
and selected file type.)

« JPEG, *.jpg
(Image file is a screen capture of the current measurement display.)

e Limit Lines, *.1lim
(The Limit Line file contains limit line data details.)

e Spurious Emission Mask, *.spe
(The Spurious Emission Mask file contains the frequency, amplitude, and other
information related to segments in an out-of-band spurious emission mask.)

e KML 2D, *.kml
e KML 3D, *.kml
¢ Mapping Tab Delimited, *.mtd

You can also use the touch screen to open the drop down list for the Filetype entry box, as
shown in Figure 4-1 on page 4-2.
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Save Files

The submenu keys that are available for file management may vary with instrument options
and measurement modes. Refer to “File Menu” on page 4-10.

Save Measurement As

The Save Measurement As submenu key provides a one-touch method of saving the current
measurement data. The name of the file that will be saved is displayed on the submenu key.
The numerical suffix increments by 1 following the Save. For example, if the last
measurement was saved with the file name ACPR, the Save Measurement As shows the
default file name for the next measurement to be saved as ACPR_1, then ACPR_2, and so on.
To save using a different file name than the default, press the Save Measurement key or the
Save key instead of Save Measurement As.

Save Measurement

To save the current measurement data, use the Save Measurement As submenu key described
above or, to apply a different file name or save location than the default, press the Save
Measurement submenu key or the Save key. In the Save dialog, you can enter the file name
and select the type of data to save. See Figure 4-1 and refer to “Save Dialog Box” on page 4-3.

Save

The Save submenu key has the same function as Save Measurement. It opens the Save dialog
box and menu illustrated in Figure 4-1.

|/1nl‘itSLl 12/15/2015 05:53:13 pm E = Save

Location: /Internal kMemory

Filename: |FiIeName_1
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1 2 Measurement & JPG 8 9 0 - =
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q|w|e|r|t|y1u i o p
Restare

Default Quick

Mame Buttans

Change

_ Z X c v b n m Guick Name

Change
Space Save Location
Change Type
Quick Name 1 Quick Name 2 Quick Name 3 Gluick Name 4 Quick Name 5
Setup/ JPEGY ..
| Freqg I Amplitude I Span I B I harker

Figure 4-1. Save Dialog Box
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Save Dialog Box

In the Save dialog, use the touch screen keyboard to enter the name of the file to save. See
Figure 4-1 on page 4-2. Optionally, you can use the Quick Name keys to insert preset text
strings into the file name. Refer to “Quick Name Keys”.

To select the type of data to save, either press the Filetype selection box to display the drop
down list of available file types, or press the Change Type submenu key. Selectable file types
vary with the measurement mode. Use the Up/Down arrow keys to highlight the desired file
type, then press Enter to select.

Press Enter again to save the file. File name extensions are automatically assigned based on
the file type and measurement mode. Refer to “File Types” on page 4-1.

Quick Name Keys

Quick Name keys in the Save dialog provide optional building blocks for entering file names.
They function as keyboard shortcuts, allowing you to enter predefined, frequently used file
names or parts of file names. To enter or change a Quick Name, press the Change Quick Name
submenu key in the Save menu, then select the item to edit (see Figure 4-2) and press Enter
on the numeric keypad. In the Edit Quick Name dialog, use the touch screen keyboard to
enter a new Quick Name. See Figure 4-3. Press Enter again and the new name will be
displayed on the key, in the Save dialog.

Select Guick Name to edit

Zuick Mame 1
Guick Mame 2
Quick Mame 3
Quick Mame 4
Quick Mame 5

Figure 4-2. Select Quick Name List Box

Edit Guick Mame

Location: /ntermal Memory

Free Space 1.5 GE

1 2 3 4 5 6 7 8 9 0 - = _

Space

Figure 4-3. Edit Quick Name Dialog Box
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Quick Name Matrix

The Quick Name Matrix key is present in the Save dialog only in the Cable and Antenna
Analyzer and 2-port Transmission measurement modes. See Figure 4-4. Similarly to the Quick
Name keys, the matrix gives field personnel a shortcut method to enter file names in
compliance with carrier requirements, which may include file naming conventions related to
site number, sector information, color coding, measurement type, termination device, or
frequency information. See Figure 4-5.
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Figure 4-4. Save Dialog Box (Cable and Antenna Analyzer Mode)
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Figure 4-5. Quick Name Matrix
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Follow these steps to define and use shortcut keys in the Quick Name Matrix. If all matrix
keys are already defined, proceed directly to Step 4.

1. To edit any matrix key, press and hold the key until the Edit Quick Name dialog opens.
See Figure 4-3 on page 4-3.

2. Use the touch screen keyboard to enter a new key label, then press Enter.
Repeat the steps above to define more Quick Name Matrix keys, until done.

Press the matrix key with the appropriate label to enter the desired text string at the
insertion point, in the Filename entry box. Press the Esc key to undo. You can use the
Space and Underscore keys to insert separators in the file name.

5. Repeat Step 4 as needed until the file name is complete.

Note that the Keyboard key (see Figure 4-5 on page 4-4) closes the Quick Name Matrix
screen and returns to the Save dialog. The next steps can be performed from either
screen.

6. Select the file type to save, either from the drop down list or by using the Change Type
submenu key.

7. Optionally, press the Change Save Location submenu key to select a different save
location.

8. Press Enter to save the file.

Change Save Location

You can save files to internal memory or to an external USB flash drive. To change the
destination location of the saved file, press the Change Save Location submenu key under the
Save menu. Figure 4-6 illustrates the directory structure of the instrument’s internal memory
and external USB drive or drives, if connected. Only folders are listed, not files.
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Figure 4-6. Save Location Screen
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Use the touch screen, the Up/Down arrow keys, or the rotary knob to select a folder from the
list. To expand a folder and view its subfolders, press Enter or the Right arrow key. Press
Enter again or the Left arrow key to collapse the folder. To create a new folder, press the
Create Folder submenu key.

After selecting the folder, press the Set Location key to store the save location. Refer to
“Save Location Menu” on page 4-12 for a description of the submenu keys.

Save On Event

This menu is not available in all modes of operation. The menu is used to automatically save
measurement data to the current save location after a selected event type. Refer to
“Save On... Menu” on page 4-13.

Recall Files

Press the Recall Measurement key or the Recall key under the File menu to recall a previously
saved file from internal memory or an external USB drive, if connected. The files listed in the
Recall dialog box depend on the file type selected. See Figure 4-7. JPEG image files cannot be
recalled.
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Figure 4-7. Recall Dialog Box

The submenu keys let you change the file types and sort order of the displayed file list. Refer
to “Recall Menu” on page 4-14.

The Filetype drop down list has the same function as the File Type submenu key. Selectable
file types vary with the measurement mode. Use the touch screen, rotary knob, or the
Up/Down arrow keys to select the file you wish to recall, then press Enter.

From the Recall dialog box, you can create a shortcut to a setup file and place the shortcut
icon on the instrument’s Menu screen. Refer to “User-Created Shortcuts” on page 2-5.
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Copy Files

Press the Copy key under the File menu to open the Copy dialog box and menu, where you
can copy a single or multiple files or folders. The source and destination locations may be the
instrument’s internal memory or an external USB drive, if connected. The source files listed
in the Copy dialog box depend on the chosen file type, which is selected using either the
Filetype drop down list or the File Type submenu key. You can also change the way folders
and files are sorted in the displayed list. Refer to “Copy Menu” on page 4-15.

The Filetype drop down list has the same function as the File Type submenu key. Selectable
file types vary with the measurement mode. Files and folders to copy are listed in the top
pane of the Copy dialog box. Select the destination in the bottom pane. See Figure 4-8.
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Figure 4-8. Copy Dialog Box

1. To copy to or from an external USB drive, insert the flash drive into a USB port on the
instrument. Otherwise, skip to the next step.

2. Press the Shift key, followed by File (7), then press the Copy submenu key.

Use the submenu keys to select the type of file to copy and the display order of folders
and files, as appropriate.

4. Make sure the Scroll submenu key is toggled to Src (source).

Use the touch screen, rotary knob, or the Up/Down arrow keys to locate and highlight
(that is, frame) the file or folder you wish to copy. To open a highlighted folder, press
Enter. Press Enter again or press the Left arrow key to close it.

6. To select a highlighted file or folder for copying, press the Select or De-Select submenu
key. The selected item is highlighted in blue.

7. If needed, repeat Step 5 and Step 6 to select more files or folders to copy.
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8. Press the Scroll key to switch navigation control to the Dst (destination) pane.
Alternatively, you can directly press a folder in the bottom pane to select it.

9. If the destination folder is off the screen, use the rotary knob or the Up/Down arrow
keys to locate and select it.

10. Press the Copy key to copy the selected files or folders.

If a file by the same name already exists in the destination location, an error message is
displayed, prompting you to press Enter to overwrite, or Esc to skip the conflicting file.

Delete Files

Press the Delete key under the File menu to open the Delete dialog box and menu, where you
can delete a single or multiple files or folders. Items to be deleted may be in the instrument’s
internal memory or an external USB drive, if connected. However, you cannot select files and
folders located in different drives simultaneously.

The files listed in the Delete dialog box depend on the chosen file type, which is selected using
either the Filetype drop down list or the File Type submenu key. You can also change the way
folders and files are sorted in the displayed list. Refer to “Delete Menu” on page 4-16.
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Figure 4-9. Delete Dialog Box

Use the touch screen, rotary knob, or the Up/Down arrow keys to highlight the file or folder
you wish to delete. Then, press the Select or De-Select submenu key. The selected item is
highlighted in blue. Pressing the key again deselects the current item.

To delete multiple files or folders, scroll to the next item and press the Select or De-Select key.
Press the Delete key, then confirm or cancel the deletion in the confirmation box.
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4-3 File Menu Overview

4-3

File Menu Overview

Open this menu by pressing the Shift key, then the File (7) key.

Spectrum
Analyzer
Mode Only

File

Save Measurement As

FileName_1.spa

Save

Measurement

Equivalent to pressing the screen shortcut H

Save

Save

On
Event

Recall

Measurement

Recall

ey - @
Delete - e

Save On...

Save

/\/
/\/

Restore
Default Quick
Name Buttons

Recall

...Crossing Limit

On Off

Change

Quick Name

Sort By

Name Type Date

...Sweep Complete

On Off

Change

Save Location

Sort Order

Ascend  Descend

Change Type

Setup/JPEG/...

@ =

Sort By
Name Type Date
Sort Order
Ascend  Descend
File Type
ALL
Refresh
Directories

Scroll

Select
or
De-Select

Copy

File Type Save Then Stop
Measurement On Off
Refresh
Clear All
Directories
/\/
/\/
Delete
Sort By
Back
Name Type Date
L <—

Sort Order
Ascend  Descend
File Type
ALL
Select

or
De-Select

Delete

Refresh

Directories

Save Location

Name Type Date

Sort By

Sort Order

Ascend  Descend

Create

Folder

Set

Location

Refresh

Directories

Figure 4-10. File Menu
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4-4 File Menu

File Management

4-4

File Menu

Key Sequence: Shift > File (7)

File

N

Save Measurement As

FileName_1.spa
Save

Measurement
Save

Save
On
Event

Recall

Measurement

—<

Recall

—<

Copy

—<

Delete

Save Measurement As: Pressing this key will save instrument setup
parameters, trace data, and any measurement results to the file that is
named on the submenu key. Upon Save completion, the file name numerical
suffix increments by 1 and will be applied to the next Save. The file extension
is determined by the current measurement mode, such as .spa for Spectrum
Analyzer mode, or .dat for Cable and Antenna Analyzer mode.

To save to a different file name than the default shown, or to change the save
location, use the Save Measurement or the Save submenu key.

Save Measurement: Press this submenu key to display the “Save Menu”
and Save dialog box. You can optionally enter a different file name using the
keyboard in the Save dialog. You may also select the file type from the drop
down list, as illustrated in Figure 4-13 on page 4-11. The list of available file
types varies with the measurement mode.

Press Enter to save to the named file and return to the File menu. Pressing
Esc exits the Save menu and dialog without saving.

The destination file for the saved data may be in the instrument’s internal
memory or an external drive, typically a USB drive. To change the save
location, refer to the “Save Location Menu” on page 4-12.

Save: Press this submenu key to display the “Save Menu” and Save dialog
box. The available settings are the same as those of the Save Measurement
key.

Save on Event (Not available in all measurement modes): Press this
submenu key to display the “Save On... Menu” on page 4-13.

Recall Measurement: Press this submenu key to display the “Recall Menu”
on page 4-14. Use this menu to recall measurement files from internal
memory or an external drive, such as a USB memory stick.

Recall: Press this submenu key to display the “Recall Menu” on page 4-14.
The available settings are the same as those of the Recall Measurement key.
Use this menu to recall files (such as measurements, setups, limit lines,
maps) from internal memory or an external drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-15.
Use this menu to copy files and folders. The source and destination locations
may be the instrument’s internal memory or an external USB drive.

Delete: Press this submenu key to display the “Delete Menu” on page 4-16
and a selection box that lists the contents of internal memory and an external
drive if connected. Use the rotary knob or the Up/Down arrow keys to scroll
to the file that is to be deleted and press the Select or De-Select submenu
key, then Delete. Press the Esc key to cancel the operation. Note that
deleted files cannot be recovered.

Figure 4-11. File Menu
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File Management 4-4 File Menu

Save Menu
Key Sequence: Shift > File (7) > Save Measurement
Key Sequence: Shift > File (7) > Save

Save
/\/
/\/
Restore Default Quick Name Buttons: Press this submenu key to undo
Restore any Quick Names previously entered and return all Quick Name buttons to
Default Quick factory defaults.

Name Buttons . .
Change Quick Name: Press this key to change the Quick Names at the

Change bottom of the touch screen keyboard (see Figure 4-13). Select the Quick

_ Name to edit, then press Enter. Type the new Quick Name and press Enter
Quick Name again. The new Quick Name is displayed on the button below the keyboard.

Change Change Save Location: Press this submenu key to open the

“Save Location Menu”, where you can set the location of the destination file
for saved data.

Change Type Change Type
Setup/JPEGI... Press this submenu key to open the Select File Type list box
and the “File Type Menu”.

Save Location

Setup/JPEGI...

Figure 4-12. Save Menu

|Anritsu 12/15/2015 05:53:19 pm EH =& m: Save

Location: Anternal hemory

Filename: |FiIeName_1

Filetype: | reasurement j Free Space: 1.5 GB
Setup
reasurement
JPEG —
1 2 |: Measurement & JPG 8 9 0 - =
Limit Lines —

Spurious Emission Mask
RN E
Restare
Default Guick
_ a s d f q h j k |
Change
- z X c v b n m Quick Narme
———4

Change

Space Save Location

Name Buttons

Change Type

Guick Mame 1 Quick Mame & Guick Mame 3 Quick Mame 4 Guick Mame 5
Setup/JPEGY,

| Freqg I Amplitude I Span I BW I harker

Figure 4-13. Save Dialog Box
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4-4 File Menu File Management

File Type Menu

Key Sequence: Shift > File (7) > Save Measurement > Change Type

Key Sequence: Shift > File (7) > Save > Change Type

File Type

N
JPEG Capture

Full Graph Only
/

JPEG Capture

Full Graph Only: Press this submenu key to toggle between file types,
Full and Graph Only. Choose Full to include all of the additional data on the
measurement screen. Choose Graph Only to capture just the measurement
trace in the sweep window.

Figure 4-14. File Type Menu

Save Location Menu

Key Sequence: Shift > File (7) > Save > Change Save Location

Save Location

Sort By
Name Type Date
Sort Order

Ascend Descend

Create
Folder
———<
Set
Location

Refresh

Directories

/

Sort By

Name Type Date: Press this submenu key to choose the item by which
folders are sorted in the Select Save Location list. See Figure 4-6

on page 4-5.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the folder list
between Ascending and Descending.

Create Folder: Press this submenu key to create a new folder inside the
selected directory. Enter the new folder name in the Create Directory dialog
and press Enter. To return to the Select Save Location dialog without
creating a new folder, press Esc.

Set Location: Press this submenu key to set the currently selected folder as
the destination where saved files will be stored, and to return to the “Save
Menu” on page 4-11. Press Esc to exit without saving.

Refresh Directories: Press this key to update the folder list after connecting
or disconnecting an external USB drive.

Figure 4-15. Save Location Menu
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File Management 4-4 File Menu

Save On... Menu
Key Sequence: Shift > File (7) > Save On Event

...Sweep Complete

Save Then Stop

In Spectrum Analyzer mode, this menu is used to automatically save

Save On.- measurements to the current save location after any of the following events:
sl ...Crossing Limit
on off On Off: When this submenu key is set to On, measurement data is

automatically saved when the trace crosses a limit line that has been
specified with the Limit menu.

...Sweep Complete
On Off: When this key is set to On, measurement data is automatically
saved after the current sweep is completed.

Save Then Stop

On Off: Set this key to On to stop the sweep after a measurement is
saved. If this setting is Off and Sweep Complete is On, a measurement is
saved after every sweep.

— | Clear All: Press this key to turn Off all three Save On Event keys:
Clear All Crossing Limit
/ Sweep Complete
L Save Then Stop
/\_ﬂ Back: Press this key to return to the “File Menu” on page 4-10.
— \
Back
A /

Figure 4-16. Save On Menu

Site Master User Guide
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File Management

Recall Menu

Key Sequence: Shift > File (7) > Recall

Recall

Sort By
Name Type Date
Sort Order
Ascend Descend
File Type
Measurement
Refresh

Directories

Use these menu keys to change the way files are listed in the Recall dialog
box. Navigate to the desired file, then press Enter to recall.

When recalling a saved setup, all current instrument settings are replaced

by the stored setup information. When recalling a saved measurement and
multiple traces are displayed, parameter settings shown on the instrument
screen may reflect those of the recalled trace or the active trace, depending
on the measurement mode or other factors.

Sort By

Name Type Date: Press this submenu key to choose the item by which
folders and files are sorted in the Recall dialog box. See Figure 4-7

on page 4-6.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list
between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box.
Press the desired file type on the list, then press Enter to apply the
selection. JPEG image files cannot be recalled and are not listed.

Alternatively, you can select directly from the Filetype drop down list in the
Recall dialog box.

Refresh Directories: Press this key to update the file list after connecting
or disconnecting an external USB drive.

Figure 4-17. Recall Menu
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4-4 File Menu

Copy Menu

Key Sequence: Shift > File (7) > Copy

Copy

Sort By

Sort Order

File Type

ALL

Refresh

Directories

Scroll

2]
=
o

Select
or
De-Select

Copy

Name Type Date

Ascend Descend

Dst

Sort By

Name Type Date: Press this submenu key to choose the item by which
folders and files are sorted in the Copy dialog box. See Figure 4-8

on page 4-7.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list
between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box.
Press the desired file type on the list, then press Enter to apply the
selection.

Alternatively, you can select directly from the Filetype drop down list in the
Copy dialog box.

Refresh Directories: Press this key to update the file list after connecting
or disconnecting an external USB drive.

Scroll
Src Dst: Press this submenu key to shift navigation control between the
source and destination panes in the Copy dialog box.

Select or De-Select: Press this key to select or deselect the current file or
folder. Selected items are highlighted in blue.

Copy: Copies the selected files and folders, highlighted in blue in the top
pane of the Copy dialog box, to the selected location in the bottom pane. If a
file by the same name already exists in the destination location, an Error
message is displayed, prompting you to press Enter to overwrite, or Esc to
skip the conflicting file.

Figure 4-18. Copy Menu
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4-4 File Menu

File Management

Delete Menu

Key Sequence: Shift > File (7) > Delete

Delete

Sort By

Sort Order

File Type
ALL
Select

or
De-Select

Delete

Refresh

Directories

Name Type Date

Ascend Descend

Sort By

Name Type Date: Press this submenu key to choose the item by which
folders and files are sorted in the Delete dialog box. See Figure 4-9

on page 4-8.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list
between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box.
Press the desired file type on the list, then press Enter to apply the
selection.

Alternatively, you can select directly from the Filetype drop down list in the
Delete dialog box.

Select or De-Select: Press this key to select or deselect the current file or
folder. Selected items are highlighted in blue.

Delete: Deletes the selected files or folders, which are highlighted in blue.
In the confirmation box, press Yes to delete, No to cancel. You can also
press Esc to cancel the deletion.

Refresh Directories: Press this key to update the file list after connecting
or disconnecting an external USB drive.

Figure 4-19. Delete Menu

PN: 10580-00252 Rev. W Site Master User Guide



Chapter 5 — System Operations

5-1 Introduction

This chapter reviews the Site Master system operations and related menus. The other menus
(Sweep, Measure, Trace, and Limit) are described in the Measurement Guides listed in
Appendix A, “Measurement Guides”.
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5-2 System Menu Overview System Operations

5-2 System Menu Overview
To access the System menu functions, press the Shift key, then the System (8) key.

Requires Option 31

System —— GPS —— System Options — Display Settings Brightness Settings
GPS Date
Status & Brightness — Brightness
On Off Time
- —>
R
Self Ethernet Auto Dim
GPS Info —»@ Display Blank
Test Config On Off
R
Application GPS Voltage ("} Auto Dim
Self Language Default Colors Delay (min)
Test 33V 5V 15
R —
O Auto Dim
GPS _ % Display R Black on White Brightness
10.00 %
- — 0
O
Reset Name Night Vision %
—
Calibrate @)
Touch Back Volume High Contrast Back
Screen
— —
Application O
Application options vary Reset —»@ Color on White
Options with instrument mode
G =
— S —
System
More — @ Back
Options
s - —

Requires Ethernet

@ Ethernet
Type
Manual DHCP @ Reset @ System Options 2/2
.
Field Factory Share CF &
Pwr Offset
1P G-Way Sub Defaults All Modes Not Shared — Power-On
P  CEE——— o
Master Set @
First Octet Remote Access Power Switch
Reset Password
o  CE—— P P
Update WhenDC O
Second Octet Power-On —
Firmware Applied
"
Third Octet % % %
X
Fourth Octet Back Back Back
& — &

Figure 5-1. System Menu
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System Operations

5-3 System Menu

5-3

System Menu

Key Sequence: Shift, System (8)

Svstom Status: Pressing this submenu key displays the current system status,
! < | including the operating system and firmware versions, temperatures and
other details such as current battery information. Press Esc or Enter to
s return to normal operation.
Self Test: This key initiates a series of diagnostic tests related to the
el performance of the motherboard hardware. A display will list the individual
Tost tests with a pass or fail indication. Press Esc or Enter to return to normal
operation.
Appg"i“m If the self test fails when the battery is fully charged and the instrument is
T:st within the specified operating temperature, contact your Anritsu Service
,—< Center and report the test results.
. Application Self Test: This key initiates a series of diagnostic tests related
to the performance of the instrument for specific applications. A display will
/| list the individual tests with a pass or fail indication. Press Esc or Enter to
return to normal operation.
GPS : Opens the “GPS Menu” on page 6-4.
Gl e Calibrate Touch Screen: If the instrument does not respond as expected
T when you press the touch screen, press this key to display the touch screen
Screen calibration message box. Refer to “Touch Screen Calibration” on page 2-11.
Syl The front panel shortcut equivalent of this submenu key is Shift, 0 (zero).
Refer to “Calibrate Touch Screen Shortcut” on page 2-11.
CEE Application Options: This submenu changes with the measurement mode.
System Refer to the appropriate Measurement Guide, as listed in
Appendix A, “Measurement Guides”.
Opti
i System Options: This key opens the “System Options Menu” on page 5-4.
Figure 5-2. System Menu
Calibrate Touch Screen Shortcut
Note

Press Shift then 0 to open the Calibrate Touch Screen display. Press Enter to start

the calibration or Esc to cancel.

Site Master User Guide
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5-3 System Menu

System Operations

System Options Menu

Key Sequence: Shift, System (8) > System Options

System Options

Date
&
Time

Ethernet

Config

—<

Language

—<

Display
—> :
Name

—<

Volume

Date and Time: Press this submenu key to display a dialog box for setting
the current date and time. Use the submenu keys or the Left/Right arrow
keys to select the field to be modified. Use the keypad, the Up/Down arrow
keys, or the rotary knob to select the date and time. Press Enter to accept
the changes, or press the Esc key to return to normal operation without
making changes.

Ethernet Config: This submenu key is present only when Ethernet option is
installed. Press the key to display the Ethernet submenu and to open the
Ethernet Editor dialog box, where you can set the instrument IP address. For
details, refer to “Ethernet Menu” on page B-2.

Language: Press this submenu key to open a list box and select a built-in
language for the instrument display. Press Enter to apply the change, or
press Esc to cancel.

The languages that are currently available are: English, French, German,
Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You
can edit non-English language captions using Master Software Tools (MST).
If a mode does not have language translations available, then English is the
default language.

Caution: A firmware update or any instrument reset will overwrite
modifications you may have made in any of the language files.

Display: The Display submenu key opens the “Display Settings Menu”
on page 5-7, allowing brightness control and the selection of different display
attributes.

Name: Press this submenu key to open the Unit Name dialog, where you
can enter a name for the instrument, using the touch screen keyboard. Press
Enter to save the name.

The assigned instrument name appears in measurement files, setup files,
limit line files, and MST reports. It is displayed on the browser page banner
when the instrument is connected to a remote PC or mobile device.

Volume: Press this submenu key to view or adjust the speaker volume. The
current volume setting is displayed in the Volume input box. Use the numeric
keypad, the Up/Down arrow keys, or the rotary knob to change the value,
and press Enter to apply the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-9.

More: Press this submenu key to open the “System Options 2/2 Menu”
on page 5-5.

Figure 5-3.

System Options Menu
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5-3 System Menu

System Options 2/2 Menu

Key Sequence: Shift, System (8) > System Options > More

System Options 2/2

Share CF &
Pwr Offset
All Modes Not Shared

Set

Remote Access
Password

Power-On

>/

Share CF & Pwr Offset

All Modes Not Shared: Press this submenu key to toggle the setting
between All Modes and Not Shared. Select All Modes to have the current
center frequency setting and power offset setting carried over when changing
measurement modes. This function is not applicable to measurements that
do not have a center frequency or power offset setting or to measurements in
which the current center frequency or power offset setting is outside the
range of the new measurement.

Set Remote Access Password: Press this submenu key to open the
Password entry dialog (see Figure 5-5 on page 5-6). Use the touch screen
keyboard to enter the new password. Passwords may contain digits,
uppercase and lowercase letters, and the symbols -  + . (hyphen,
underscore, plus, period). Press Enter to save or Esc to cancel.

Setting the remote password and rebooting the instrument will lock it from
Telnet and FTP connections. This means that connecting to the instrument
via Master Software Tools (v2.21.1 or later), Wireless Remote Tools (WRT),
or the Web Remote Control browser interface will require the set password.
To unlock the instrument, remove the password by setting it to blank. The
password is also removed following a Master Reset, Factory Defaults reset,
or a firmware update.

Power-On: Press this submenu key to open the “Power-On Menu”
on page 5-6.

Back: Press this submenu key to return to the “System Options Menu”
on page 5-4.

Figure 5-4.

System Options Menu

Warning

Do not set a remote access password when using SCPI commands to
communicate with the instrument.

Site Master User Guide
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|Anritsu 07/20/2015 12:07:44 pm E =
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Figure 5-5. Remote Access Password Dialog

Power-On Menu
Key Sequence: Shift, System (8) > System Options > More > Power—On

Power-On
®)
Power Switch Power Switch: Press this submenu key to set the instrument for normal use
of the On/Off button on the instrument front panel.
WhenDC O When DC Applied: Press this submenu key to set the instrument to
automatically restart when DC power is applied to the External Power
Applied connector (see Figure 2-15 on page 2-17).
/\/
/\/
— N\
Back Back: Press this submenu key to return to the “System Options 2/2 Menu”
- y on page 5-5.

Figure 5-6. Power—On Menu
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5-3 System Menu

Display Settings Menu
Key Sequence: Shift, System (8) > System Options > Display

Display Settings

N
Brightness
S 2
Display Blank

<

Default Colors

—<

O
Black on White

<

Night Vision

<

(@)
High Contrast

Brightness: Opens the “Brightness Settings Menu” on page 5-8.

Display Blank: Opens the message box illustrated in Figure 5-8. Press
Enter to turn off the display, or press Esc to abort. To turn the display back
on, press any key (except the Power button) three times in rapid succession.
A power cycle also turns the display back on.

Default Colors: Sets the display colors to the factory defaults. Used for
normal viewing.

Black on White: Sets the display colors to black on a white background.
Used for printing and viewing in broad daylight conditions. See Figure 2-9
on page 2-10 for illustrations of the display color schemes selectable in this
submenu.

Night Vision: Sets the display to a red-tinted color on a black background.
The front panel keypad is backlighted in red. This setting is optimized for
nighttime viewing.

High Contrast: Increases the black and white contrast of the default
display. This setting is used in challenging viewing conditions.

Color on White: Sets the display background to white, the grid to gray, and
leaves sweep data in color. This setting is used for printing and viewing in
broad daylight conditions.

/
N . « . »
©) Back: Press this submenu key to return to the “System Options Menu
Color on White on page 5-4.
Back
< /
Figure 5-7. Display Settings Menu
Display Blank

Ta turn off the display, press <Enter=,
or press <Esce to abort.
Three rapid keypresses,
ar turning power off and an,
will turn on the display.

Figure 5-8. Display Blank Message Box
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System Operations

Brightness Settings Menu

Key Sequence: Shift, System (8) > System Options > Display > Brightness

Brightness Settings

Brightness

Auto Dim

On Off

Auto Dim
Delay (min)
15

Auto Dim

Brightness
10.00 %

/\/
/\/

Back

The brightness of the display can be adjusted to optimize viewing under a
wide variety of lighting conditions.

Brightness: Press this submenu key to open the Brightness Editor window,
where you can adjust the display brightness level from 0 to 100, with 100
being the brightest. See Figure 5-10. Use the rotary knob to adjust the value
in increments of 5, or press the Up/Down arrow keys to change the value in
increments of 25. Press the Left or the Right arrow key to jump to 0 or 100,
respectively. Press Enter to accept the change. All display elements on the
instrument screen are affected by the Brightness setting.

Auto Dim On/Off: Press this submenu key to toggle the display
auto-dimming feature on and off. Enabling auto-dim can extend battery life.

Auto Dim Delay: Press this key to adjust the amount of idle time, from 1 to
15 minutes, before the instrument display goes dim. Use the arrow keys or

the rotary knob to adjust the value in increments of 1. You can also use the

numeric keypad, then press Enter. Out-of-range values are ignored.

Auto Dim Brightness: Press this submenu key to select the brightness
percentage level of the display when it is dimmed. Use the arrow keys or the
rotary knob to adjust the value in increments of 5%, from 0% to 25%. You can
also use the numeric keypad, then press % or the Enter key. Out-of-range
values are ignored.

Back: Press this submenu key to return to the “Display Settings Menu”
on page 5-7.

Figure 5-9.

Brightness Settings Menu

Erightness Editor

o

Figure 5-10. Brightness Editor Input Box
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5-3 System Menu

Reset Menu

Key Sequence: Shift, System (8) > System Options > Reset

Reset

Factory
Defaults
Master
Reset
Update

Firmware

Factory Defaults: Press this key to restore the instrument to the default
settings for all measurement modes and system settings, including
connectivity, language, and the display and audio settings. The instrument
will power cycle when the operation is complete. Press the Enter key to
initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning on the
instrument by pressing Power while holding down the Esc key until
the Anritsu splash screen is displayed.

Master Reset: Press this submenu key to restore the instrument to factory
defaults as described above and to delete all user files from the instrument
internal memory. The instrument will power cycle when the operation is
complete. Press Enter to initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning on the
instrument by pressing Power while holding down the System (8) key
until the Anritsu splash screen is displayed.

Update Firmware: Press this submenu key to update the instrument
operating system using an external USB drive. Press Load Firmware to start
the update procedure, or press the Menu key to cancel and display the Menu
key screen of application icons. Refer to “Firmware Update” on page 5-11 for
detailed instructions.

Back: Press this submenu key to return to the “System Options Menu”
on page 5-4.

Figure 5-11. Reset Menu
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5-4 Preset Menu
Key Sequence: Shift, Preset (1)

Preset: This key resets all parameter settings for the current measurement

Preset mode to their factory default values, and switches the display to the default

N
view for that mode. Measurement settings specific to other modes, or
Preset applications, are not affected.
Save Setup: Opens the Save dialog box (see Figure 4-1 on page 4-2) to
SE0 name and save the current operating settings, allowing them to be recalled
Setup later to return the instrument to the state it was in at the time the setup was
saved.
Recall The saved setup can be named using the touch screen keyboard. Use the
Setup Caps key to select an uppercase letter. Use the Left/Right directional

arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. See “Save Menu” on page 4-11 for details.

Recall Setup: This key allows the selection and recall of a previously
stored instrument setup using the “Recall Menu” on page 4-14. Use the
rotary knob, the Up/Down arrow keys, or the touch screen to highlight the
saved setup, and press Enter. All current instrument settings are replaced
by the stored setup information.

Figure 5-12. Preset Menu

5-5 Self Test

At power on, the Site Master runs through a series of quick checks to ensure that the system
is functioning properly. The System self test runs a series of tests that are related to the
instrument hardware. The Application self test runs a series of tests related to the
instrument hardware that is used in the current operating mode.

If the Site Master is within the specified operating range with a charged battery and the self
test fails, contact your Anritsu Service Center at anritsu.com/contact-us.

To initiate a self test when the system is already powered up:
1. Press the Shift key, followed by the System (8) key.
2. Press the Self Test submenu key. The Self Test results are displayed.
3. Press Esc to close the Self Test results dialog.
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5-6

Firmware Update

To update your Anritsu instrument firmware, use a high quality USB memory device with at
least 250 MB of free space and FAT32 file system format.

1. Insert the memory device into your PC or laptop.

2. From a browser, go to the following Anritsu Products page:
http://www.anritsu.com/en-US/test-measurement/rf-microwave/cable-and-antenna-ana
lyzers

3. If the Web page lists more than one product, find your instrument model number and
click the link.

On the product page, press the Downloads button.

Under the Drivers/Firmware/Software tab, you can optionally follow the Firmware
Revision/Release History link to download a document detailing current and past
firmware changes.

6. Click on the link Firmware Update for the Site Master S3xxE.

Click the Download button, then choose Save or Save As. Do not run the executable file
directly from the Web page.

8. Go to the Save location designated in Step 7 and double-click the installer file,
Model_Ver_USBLoader.exe.

9. In the Firmware Update dialog, click to view, then accept the software license
agreement.

10. Click Browse and select the Removable Disk drive where the USB device is inserted.

11. Click Prepare USB Memory Stick to create the firmware update USB device.

12. After the firmware update tool has finished, click through the final steps in the
Firmware Update dialog to close the installer program.

13. Eject the memory device from the computer.

Note The file structure created on the USB memory device by the installer program is
necessary for a successful firmware update and must not be altered in any way.

14. Turn off the Site Master and insert the USB memory device into the instrument.

15. Make sure the Site Master is plugged into an AC power source and not running on
battery alone, then turn on the instrument.

16. At bootup, the instrument should detect new firmware on the USB device and ask if

you wish to upgrade. Press Yes.
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17. The Automatic Firmware Update dialog should open at this time. Skip to Step 19.

Note

If the same firmware code as contained on the USB device is already loaded on
the instrument, a message indicating that firmware update is skipped will display
briefly on the instrument screen.

If the firmware update on the memory device does not match your instrument
model, an error message will display briefly, indicating that it is not compatible.

18. If there is no error but the instrument does not enter upgrade mode automatically:

a.
b.
c.
d.

Press Shift > System (8) > System Options > Reset > Update Firmware.
Press Load Firmware at the bottom left of the instrument screen.
Press Update Application Firmware.

The Firmware Update dialog opens.

19. Use the Up/Down arrow keys or the rotary knob to select one of the Save modes.

Save none: No attempt is made to save any user data.
Save user data: User data is saved to the selected external media device.

Save & restore user data: User data is saved to the selected external media
device. The instrument also attempts to restore the files to the instrument after
the update.

Warning

Some user data may be lost if not enough memory space is available on the
selected device.

20. Press Enter.

21. Press Enter again to confirm your intention to proceed with the firmware upgrade.

To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and
select an application from the Mode Selector list in order to exit upgrade mode and
resume normal instrument operation.

Warning

You cannot stop the upgrade once it has started. To avoid potential permanent
damage, do not turn off the instrument or remove the USB memory device during
the firmware update.

22. After the update is complete, the instrument should reboot automatically.

Note

If the instrument turns off and does not restart on its own, remove the USB memory
device and turn on the instrument by holding down the System (8) key, then
pressing the Power button. Keep pressing System (8) until the Anritsu splash
screen is displayed.

Be sure to use this key combination in order to perform a Master Reset while
turning on the instrument. Pressing the Power button alone may put the instrument
in an unrecoverable error state.
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Chapter 6 — GPS (Option 31)

6-1 Introduction

The Site Master is available with a built-in GPS receiver feature (Option 31) that can provide
latitude, longitude, altitude, and UTC timing information. This option also enhances
frequency reference oscillator accuracy in the spectrum analyzer mode. When GPS is actively
locked to satellites, this information is saved with all saved measurements and can be
displayed with Master Software Tools. No accuracy specifications apply if no GPS satellites
are acquired.

The Site Master Technical Data Sheet provides a list of the options and
measurements that require GPS (Option 31). In addition to having Option 31
installed, a GPS antenna is required. Refer to the instrument Technical Data Sheet
for compatible GPS antennas.

Note

6-2 Activating the GPS Feature

Attach the GPS antenna to the GPS Antenna connector on the top of the instrument.

1. Press the Shift key, then the System (8) key on the numeric keypad to display the
System menu.

2. Press the GPS submenu key.

Activate GPS by pressing the GPS On/Off submenu key so that On is underlined. When
GPS is first turned On, the GPS icon is displayed in red to indicate that fewer than four
satellites are currently being tracked.

Figure 6-1. GPS Icon, Red
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6-2 Activating the GPS Feature GPS (Option 31)

4. When the GPS receiver is tracking at least four satellites, the GPS icon changes to
green. Latitude and longitude information is displayed in the title bar at the top of the
display. Acquiring satellites may take as long as three minutes.

Figure 6-2. GPS Icon, Green

5. Press the GPS Info submenu key to display the following information:
* Tracked satellites
e Latitude and longitude
o Altitude
e UTC timing information
e Fix available
e Almanac complete
* Antenna and receiver status
¢ GPS antenna voltage and current
Refer to “GPS Menu” on page 6-4 for details on the above GPS Info items.

After GPS location fix is attained, the internal reference oscillator begins to correct its
frequency to match the GPS standard. After the internal frequency is adjusted to match the
GPS standard, the status is indicated by “GPS High Accuracy” showing in the Status menu,
which is displayed on the left side of the measurement display. When the GPS feature is not
enabled, the reference source displays either “Internal Standard Accuracy” or a user-selected
external reference frequency in the Status menu.

Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of
better than 50 ppb (parts per billion).

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites,
or the antenna must be placed outside with no obstructions.

If no GPS is connected, the Frequency Reference annotation reads Int Std Accy. When GPS is
connected, with a fix, and the tuning process has completed (which may take a few minutes),
the Frequency Reference annotation shows GPS Hi Accy. If GPS is subsequently lost (for
example, GPS is turned off, disconnected, or there is no signal due to physical obstruction),
the instrument goes back to Int Std Accy after a few moments.
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6-3 Resetting GPS

To reset the GPS, press the Reset submenu key. The green GPS icon shows a red cross mark
when satellite tracking is lost after tracking four or more satellites. The GPS latitude and
longitude are saved in the instrument memory until the Site Master is turned off or until
GPS is turned off by using the GPS On/Off key.

Figure 6-3. GPS Icon, Tracking Lost

6-4 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to
“Save Menu” on page 4-11 for more information. The current GPS coordinates will be saved
with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, the coordinates will be recalled when
the measurement is recalled. Refer to “Recall Menu” on page 4-14 for more information on
recalling a saved trace.
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GPS (Option 31)

6-5 GPS Menu
Key Sequence: Shift, System (8) > GPS

GPS

GPS
on off
GPS Info
GPS Voltage

33V 5V
C—

/\_/
/\_/

Reset

—<

Back

GPS: Press this submenu key to turn GPS on or off.
GPS Info: Press this submenu key to display the current GPS information.

Tracked Satellites: Shows the number of tracked satellites (three are
required to retrieve latitude and longitude, four are required to resolve
altitude). Generally, the larger the number of satellites tracked, the
more accurate the GPS information.

Latitude and Longitude: Shows location in degrees, minutes, and
seconds.

Altitude: Shows altitude information in meters.
UTC: Universal Coordinated Time.

Fix Available: The cold start search sets are established to ensure
that at least three satellites are acquired within the first couple of
minutes. When three satellites are found, the receiver will compute an
initial fix (typically in less than two minutes). Fix Available: No means
that the initial position has not been established.

Almanac Complete: The system almanac contains information about
the satellites in the constellation, ionospheric data, and special system
messages. In a cold start, the GPS receiver has no navigation data, so
the receiver does not have a current almanac. A complete system
almanac is not required to achieve a first position fix. However, UTC
time is not correct until the almanac is complete, and the availability of
the almanac can significantly reduce the time to first fix.

Antenna Status:
OK: Active antenna is connected and is working properly.

Short/Open: If an active antenna is in use, a short or open exists
between the antenna and the connection. If this message is displayed,
replace the antenna. If the message persists, try another Anritsu GPS
antenna. If needed, contact your nearest Anritsu Service Center. If a
passive antenna is in use, the message should display: Antenna
OPEN Detected or Passive Antenna Used.

Receiver Status: Current status of the receiver.
GPS Antenna Voltage and Current: Shows voltage and current.

GPS Voltage: Press this submenu key to set the source voltage at 3.3 V or
5V, depending on the GPS receiver being used. The default setting is 3.3 V
to prevent accidental damage to lower-voltage GPS antennas.

Reset: The Reset key sets the number of tracked satellites to 0 and erases
any almanac data and saved coordinates. The process of searching for and
reacquiring satellites will begin again.

Back: Press this submenu key to return to the “System Menu” on page 5-3.

Figure 6-4. GPS Menu

6-4
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Chapter 7 — Bias Tee (Option 10)

7-1 Overview

Option 10 provides a bias tee that is installed inside the instrument. The bias arm is
connected to a 12 VDC to 32 VDC power source that can be turned on as needed to place the
voltage on the center conductor of the instrument’s RF In port. This supply of bias implies it is
mostly useful when conducting two-port transmission measurements. This voltage can be
used to provide power to block down-converters in satellite receivers and can also be used to
power some tower-mounted amplifiers.

The bias can be turned on only when the instrument is in transmission measurement, return
loss, cable loss, VSWR, DTF, or spectrum analyzer mode. When bias is turned on, the bias
voltage and current are displayed in the lower left corner of the display. The 12 VDC to

32 VDC power supply is designed to continuously deliver a maximum of 6 watts.

The bias tee menu can be accessed from the applications options menu and in transmission
measurement, it can also be accessed from the Measure main menu.

RF IN

|Anritsu 83625 SiteMaster T

Figure 7-1. Variable Bias Tee
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Chapter 8 — Anritsu Tool Box

8-1 Introduction

The Anritsu Tool Box is a suite of applications that provide an interface between Anritsu
handheld RF instruments and a PC. The instrument connects to the computer via a USB,
Ethernet, or serial port. Depending on the application selected, available functions range
from the capture, transfer, and reporting of measurement data for trace analysis, to coverage
and interference mapping, and the delivery of work instructions.

Tool Box applications are available for download from the Anritsu website at
anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box.
Click the link to one of the Tool Box applications, then click Downloads and choose either the
Full Installer or Web Installer. There is no difference between the two if you run the installer
without saving. If you elect to save, the Full Installer will download all Anritsu software
needed in a single executable file, which allows you to perform the installation later on a
computer with no Internet access required. The Web Installer is a much smaller file that will
require Internet access to execute the software installation.

8-2 Software Installation

Whether running the installer directly or executing the saved file, follow the instructions on
screen. The Setup screen illustrated in Figure 8-1 may change with the software version.

You will be asked to select which applications you wish to install. Not all instrument models
are supported by every software tool. To view the list of instrument models supported by a
Tool Box application, click the Instruments tab on the application Web page.

A, Anritsu Software Tool Box V1.13.0000 l = é]

Anritsu A Welcome to Anritsu Software Tool
Tool Box Box Setup

Anritsu Tool Box software includes tools to:

Line Analyze Cable, Antenna and PIM traces and genarata
Sweep reports. This works with DAT, VNA, MNA, and PIM files.

Master Analyze spectrum analyzer, intarference analyzer, and
Software  transmitter test measurements as well as generate reports.

Wireless Remotely monitor and control many Anritsu handhald RF
Remote  instrumeants over Wi-Fi or Ethernsat cables.

casyTest Create work instructions that can be run on Anritsu
handhald RF instruments.

easyMap Creata maps for Anritsu handhald spactrum analyzers to
simplify coverage measurements and interference hunting.

[ Help “ Mext > | [ Cancel

| %

Figure 8-1. Anritsu Tool Box Setup Wizard
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8-3 Anritsu Software Tool Box

Anritsu Tool Box

8-3  Anritsu Software Tool Box

The Anritsu Tool Box serves as a central location from which you can open a previously saved
measurement, visit the Anritsu website, or launch an application. To open the Tool Box,
either double-click the desktop shortcut or select Anritsu Tool Box from the Windows Start
menu. On the Tool Box screen, hover the mouse pointer over any of the application icons to
view a short description of the application. See Figure 8-2.

A, Anritsu Tool Box

Utilities

Applications
Open File Line Sweep Tools |
MST |
Anritsu Web /N m
a:0)
Wiy
e
easyMap Tools -
Line Sweep Tools provides post-capture
processing for antenna and transmission line
sweeps. This tool allows line sweepers to
fulfill network operator requirements for
trace submission.
Copyright © Anritsu Company 2015 - Anritsu Tool Box - V2.6 Build: 0

Figure 8-2.

Anritsu Tool Box Screen

8-2
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Anritsu Tool Box 8-4 Software Tools

8-4  Software Tools
The Anritsu Tool Box provides links to the software tools installed on your PC. Alternatively,
you can launch an application using its desktop shortcut or through the Windows Start menu.

The following sections list the top features and functions of the tools contained in the Anritsu
Tool Box. For a detailed description of these features and how to perform specific tasks, refer
to each application’s Help system. The program Help also lists the instrument models,
measurement modes, trace types, and file types that are compatible with that application.

Line Sweep Tools (LST)

Line Sweep Tools is post-capture trace processing software designed for users who need to
analyze and generate reports on large numbers of cable, antenna, and PIM traces. Software
features include:

¢ Measurement plot data capture and transfer from the instrument to a PC

¢ Marker and limit line presets

¢ Return Loss, Distance-to-Fault, PIM analysis

e« LMR Master and VNA Master Field Mode compatibility

« Plot overlay for comparison of up to ten traces of the same measurement type
* Plot area zooming

¢ A naming grid for renaming files, titles, and subtitles

e Automated report generation

e OQutput to printer or to PDF or HTML format

e Export of plot data to text, image, or VNA files

Master Software Tools (MST)

Master Software Tools is designed for users of Anritsu handheld spectrum analyzers,
interference analysis tools, transmission testers, and backhaul testers. Supported functions
include the following:

» Transfer of captured measurement data to and from a PC for storage and analysis
e RF Spectrum Analyzer traces

e RF Interference analysis

e Spectrum monitoring

e Transmitter signal quality tests

e T1, T3, and E1 backhaul tests

» Trace overlay features for comparing multiple Spectrum Analyzer measurements
¢ Limit lines and markers

e Script Master for the creation of automated test procedures

* Export of measurement data as text, graphic, or Comma Separated Value format (CSV)
files

* Reports created in HTML format for use in other applications
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easyTest Tools

easyTest Tools is used to create work instruction files that consist of a command sequence
and intructions to help less experienced personnel with operating the instrument in the field.

e A drag-and-drop tool facilitates the creation of a test sequence from a library of
commands.

e Instructions can be a mix of textual prompts and graphic images.
* Sample procedure files (.ett) are included with easyTest Tools.

» Command sequences are delivered electronically and loaded on the instrument, where
they are recalled with a press of a button.

* Recall Setup places the instrument in the proper mode for the measurement by
retrieving saved parameters such as measurement type, frequency and amplitude
settings, markers and limit lines.

e The current measurement setup or the screen display can be saved manually or
automatically.

easyMap Tools

easyMap Tools is the new name for Anritsu Map Master. The application allows users to find
and prepare geo-referenced maps and to build floor plans suitable for Anritsu Handheld
Spectrum Analyzers with Interference Analysis or Coverage Mapping capabilities (Option 25
or Option 431, respectively).

Software functions include:
» Creation of geo-referenced maps with pan and zoom capability

» Conversion of maps and floor plans to a form suitable for use on Anritsu Handheld
Spectrum Analyzers and Interference Analyzers

e Introduction of GPS information into previously non-geo-referenced maps

Wireless Remote Tools

Wireless Remote Tools enables the user to remotely monitor and control the instrument over
a wireless LAN connection.

¢ The wireless connection is typically established using a USB-powered Wi-Fi router
attached to the instrument and a matching Wi-Fi link on the PC end.

* Remote monitoring and control of the instrument enhance operator safety and
efficiency when conditions make it unsafe or impractical to be close to the instrument.
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Chapter 9 — Web Remote Control

9-1 Introduction

Web Remote Control capabilities are embedded in the Site Master, providing full instrument
control through an HTML-5 compatible browser. Ethernet option is required. The ability to
remotely monitor and control the instrument from the ground or desk enhances operator
safety and efficiency when conditions make it unsafe or impractical to be close to the
instrument. Login passwords can be used to allow access to authorized users only.

A remote connection terminates when the user logs out or closes the browser, or when the
session time requested at login expires. To prevent multi-user conflicts, only one connection is
permitted at a time. A second user who tries to log in will see a message indicating the
instrument is currently reserved by another client, with the time remaining in their session.

While only one user can have control of the instrument, multiple users can view the same
instrument using a desktop sharing application.

9-2 Setup

You can connect one or more instruments to any computer with HTML-5 compatible browser.
Anritsu strongly recommends using Google Chrome, as other browsers do not fully support
HTML-5. The control device may be a laptop, a desktop computer, or a mobile device,
including a wide range of tablets and smart phones running Android or iOS operating
systems. Note that you cannot download files to an i0OS device, for lack of a user-accessible file
system in this environment.

Physical connection is established from the instrument’s Ethernet port directly to the
computer, or to a LAN or a Wi-Fi router such as the TP-Link TL-WR802N Wireless Router.

LAN Connection
1. Connect the Ethernet port of the Site Master to your LAN.
2. Press Shift followed by System (8).

3. Press the Status submenu key to display the Status window and take note of the
instrument IP address.

Press Esc to close the Status window.

4. If no IP address has been assigned, refer to Appendix B, “LAN and DHCP” for
information on setting an IP address for the instrument. If connecting to another
network, we recommend that you request a static IP address from your network
administrator to avoid duplicate addresses.

Alternatively, you can set the instrument for dynamic IP addressing using DHCP.
Refer to “Ethernet Menu” on page B-2. In a long distance network, however, it may be
difficult or impossible to determine what the current dynamic address is, after the
instrument is in the field.
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9-2 Setup Web Remote Control

Set instrument parameters as appropriate, such as measurement mode, frequency
range, amplitude. You may skip this step and set up the instrument remotely at a later
time, after Ethernet connection has been established.

Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to
compatibility issues with HTML-5, do not connect using another browser than Chrome.

Enter the instrument IP address in the browser address bar to open the Web Remote
Control Login page illustrated in Figure 9-1 on page 9-3.

Connection to a Wireless Router

Instead of connecting the instrument directly to a LAN, you can connect it to a Wi-Fi router.
This section documents connection to a TP-Link TL-WR802N Wireless Router as an example.

1.

Configure your Anritsu instrument with the following Ethernet settings:

TP Address = 192.168.0.50
Default Gateway Address = 0.0.0.0
Subnet Mask = 255.255.255.0

Refer to “Ethernet Menu” on page B-2 for information on setting the IP address.

Using the Ethernet cable included with the router, connect one end to the LAN port and
the other end to the test instrument’s Ethernet port.

Insert the micro-USB end of the provided cable into the router’s Power port and the
Type-A end into one of the USB ports of your test instrument.

Connect your PC, laptop, or mobile device to the router via Wi-Fi, using the SSID and
pre-programmed password that are printed on the router label. For example:

SSID = TP-LINK_39DE
Wireless password = 02850450

Launch the Google Chrome browser on your computer. Due to compatibility issues with
HTML-5, do not connect using another browser than Chrome.

In the browser address bar, enter the instrument IP address set in Step 1 to open the
Web Remote Control Login page illustrated in Figure 9-1 on page 9-3.

If you need to restore the router’s factory configuration:

1.

Ne s

Connect your PC, laptop, or mobile device to the router via Wi-Fi as described in Step 4
of the previous procedure.

In the Chrome browser, enter the URL address tplinkwifi.net. You can also log in using
one of the router’s default IP addresses, 192.168.0.1 or 192.168.0.254.

Log in to the router using the default credentials:

username: admin
password: admin

Click Quick Setup.
Set the router as an Access Point and click Next until Quick Setup is completed.
Review the settings, then reboot the router using the on-screen Reboot button.

Enter the instrument IP address in the browser address bar to open the Web Remote
Control Login page illustrated in Figure 9-1.
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Web Remote Control 9-3 Web Remote Control Interface

9-3

The Web Remote Control Login page opens following browser connection to the instrument.
See Figure 9-1. The page may show or hide certain elements depending on device
management options set by the Administrator, as described in “Device Options” on page 9-11.

Web Remote Control Interface

(o o=

= C' | [ 172.26.202.155/Logout =
S362E IP Address: 172.26.202.155

Password: ||

Login as Admumstrator

Time Requested (up to 10 hours): 1 v hours 0 ¥ |minutes

Login

Enter your password and press Login to continue.

Figure 9-1. Login Page

User Login

To start a remote session with a test instrument:

1.

Enter the instrument IP address in the Google Chrome address bar. The instrument
must be connected via Ethernet as described in “Setup” on page 9-1.

Use the pull-down menus on the Login page to set the time, in hours and minutes,
before the remote session times out. The default session time is 1 hour, with a 10-hour
maximum.

Only one user at a time can connect to the instrument. To avoid locking out other users
unnecessarily, do not reserve a longer session than you need.

To enable functions available only to the network administrator, select the Login as
Administrator checkbox.

Enter the instrument password, then click Login.

The default administrator password is “Admin” with a capital A. The default password
for other users is None; that is, leave the field blank.

If another user already has control of the instrument when you try to log in, a message will
display indicating the instrument is currently reserved by another client, whose IP address is
listed with the time remaining in their session.

Following login, the Web Remote Control Home page is displayed.
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Web Remote Control

Home Page

The Web Remote Control Home page lists the same information as what is displayed on the
instrument screen when you press Shift, System (8) at the front panel, followed by the Status

menu key.

At the top of the page, a green banner shows the instrument model number and IP address. If
the instrument has been assigned a name, this name is displayed in the center of the banner.

The menu bar below the banner consists of tabs for commands and links: Home, Remote
Control, Capture Screen, Capture Trace, File List, Device Management, and Logout.

Fi) Anritsu S362E Remote Acc X Y%
« C [} 172.26.202.155/HOME

Capture Screen

Capture Trace File List

o
n

IP Address: 172.26.202.155

Device Management Logout

System Information

Package D01.07.0011
0s D4.11.0107
Base T405.53.0107
ATA Boot V36l
Keypad V236

Temperature 490C/1202F
Battery Charge 16 %
Battery Current -1.801A
Battery Voltage 100V
Serial Number 123456789

Installed Components

Spectrum Analyzer D6.81.0107
Power Meter D6.81.0107
Channel Scanner D6.81.0107
Interference Analyzer D6.81.0107
CW Signal Generator D6.81.0107
AM-FM-PM Analyzer D6.81.0107
PIM Analyzer D6.81.0107
Vector Network Analyzer D5.74.0107
High Accuracy Power Meter D3.54.0107
Transmission Measurement D6.36.0107
CPRI Mode D1.12.0107

10 Bias Tee
19 High Accuracy Power Meter
21 Trans. Meas
25 Interference Analyzer
27 Channel Scanner
28 CW Signal Generator
29 Power Meter
411 Ethernet
431 Coverage Mapping
509 AM/FM/PM Analyzer (DEMOD)
CPRI Mode 751

Figure 9-2.

Web Remote Control Home Page
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Web Remote Control 9-3 Web Remote Control Interface

Remote Control

The Remote Control page displays a bitmap image of the instrument screen. The buttons on
the right of the display reflect the layout of the buttons on the instrument and are used to
access the same monitoring and control functions. See Figure 9-3.

S362E TP Address: 172.26.202.155

Home Remote Control Capture Screen Capture Trace File List Device Management Logout

= Session Time Remaining
/INritsu o4 22016 12:02:33 pm = Freq 112 ‘ 2 hours, 55 minutes ‘

Center Freg

Ref Lvl _ c _ _ _ o
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Input Atten Start Freq
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Stop Freg

= I o
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Figure 9-3. Remote Control Page

¢ When clicking a key or measurement icon on the Remote Control page, a
small green dot appears at the point of the cursor to indicate that the key,

Not button, or icon was pressed.
ote
¢ Asingle Web-enabled device can monitor and control multiple instruments.

However, multiple Web-enabled devices with different IP addresses cannot
connect to the same instrument simultaneously.

Session Time Remaining

This is the amount of time remaining before your remote session automatically terminates.
The session time is reserved at login. It can be changed on the Device Management page.

Normal Mode

Normal Mode is the default mode, where the bitmap image of the instrument screen is
continually refreshed in the browser window. Click the single arrow button near the bottom
right of the page to return to Normal Mode from either Fast or Pause Mode. Clicking any tab
on the menu bar also returns to Normal Mode.
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Fast Mode

Click the double arrow button to enter Fast Mode, where the update rate can be significantly
faster than Normal mode, especially over low bit-rate connections. Only the measurement
data (yellow trace) is continually updated. The main menu keys and submenu keys may look
different than in Normal Mode, but their functions are the same. Error messages are not
shown in Fast Mode.

Fast Mode is not available with some Spectrum Analyzer measurement types, in which case
the Fast Mode button is disabled. The button is not displayed when the measurement mode is
something other than Spectrum Analyzer.

While in Fast mode, if a measurement type is selected that Fast mode does not support, the
instrument will return to Normal mode.

Pause Mode

Clicking the Pause button turns the Communication Activity dot in the lower right-hand
corner to yellow. If the interface was in Normal Mode, this stops the instrument display from
refreshing in the browser window. If the interface was in Fast Mode, the trace measurement
stops updating. Click the single arrow or the double arrow button to resume remote
communications with the instrument in Normal or Fast Mode, respectively. The
Communication Activity dot then returns to green.

Communication Activity

The moving dot labeled Communication Activity, when green, indicates that ongoing
communication is occurring between the instrument and PC. When you click Home, Capture
Screen, Capture Trace, File List, Device Management, or Logout on the menu bar, the
Communication Activity dot briefly turns yellow before the selected page opens in the
browser.

Configure Timeout

If the Ethernet connection is poor and you expect frequent lags in response time, you can
increase the timeout up to 20 seconds, before the instrument sends an “Instrument Busy”
message. The default timeout is 3 seconds.
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Capture Screen

Captures a JPEG image of the current instrument display and saves it directly to internal
memory. A file name is automatically created using the current date and time stamp. The
captured display is loaded to the browser page, under the menu bar. See Figure 9-4. In
Windows, you can right-click on the screen image and select Copy. With 10S, press and hold
on the picture. This makes it easy to create documentation using screen captures.

Home Remote Control Capture Screen Capture Trace File List Device Management Logout

[ Anritsu veresrens 120008 pr E] - Freq 162 |

—

Ref Lvl

M1 -54.47 dBn 0 MHz I
-45.0 dBm

Input. Atten Center Freq 751.000 MHz Start Freg

I 8 n 741.000 MHz
Stop Freg l

761.000 MHz

ru’ﬁ'f~.,"“I"{,"HIWU'\N«.-*
|

|m LUt

|
- | Signal
Traces I ‘l,l[l,.jih’ Jw ‘ ‘
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741.000 MHz 7 R S '

Amplitude Marker L

Figure 9-4. Capture Screen Page

Capture Trace

Opens an input dialog to enter a name for the trace to be saved. See Figure 9-5. After clicking
Save, a confirmation dialog opens to indicate the trace was successfully saved to the
instrument.

Home Remote Control Capture Screen Capture Trace File List Device Management Logout

Save Measurement

Filename Trace 07

Save

Figure 9-5. Capture Trace Page

Depending on the browser and operating system used, different prompts may appear. Some
operating systems like 10S may not support file saving from a browser.
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File List

Displays the list of folders (type “dir”) and files contained in the instrument's internal
memory. See Figure 9-6. To view the contents of a folder, click on the folder name.

V4] Anritsu S362E Remote Acc X

& = @ [[)17226.202.155/FileList ~ =
S362E IP Address: 172.26.202.155
Home Remote Control Capture Screen capture Tace ([ EEEEI o:vice Management Logout
D/L Select File Type Modified Size
Anritsu_Spapshot dir THU 12/02/2015 02:37 PM
Test File 01 spa spa THU 12/02/2015 02:50 PM 33.7KB
3_23 2016_141635 jpg ipg WED 23/03/2016 02:16 PM 2016 KB
Download

Figure 9-6. File List Page

To download a file, click the file name. Alternatively, you can select the checkbox on the left of
the file name, then click Download. You may also select the checkboxes of multiple files and/or
folders and download them together, as a zipped folder. In this case, a pop-up dialog box
shows the estimated download time. Press OK to continue.

Note Some operating systems, like iOS, do not support file downloads.

Depending on the browser and operating system, the download function may allow you to
open the file or save it, or both. In Google Chrome, for example, the downloaded file or files
are automatically saved to the designated folder on your computer, such as the Downloads
folder. In the banner at the bottom of the browser window, click a downloaded item to open it.

If the selected item is a single file, the file will open in the default application for the file type.
For example, a JPEG file will open in the computer's default image viewer, while a
measurement file will open in Master Software Tools (MST), provided the application is
installed.

Device Management (not as Administrator)

Click the Device Management tab on the menu bar to set or clear the instrument password, to
assign a device name to the instrument, or to change the session time. See Figure 9-7.

If you logged in as Administrator, the Device Management page has additional sections for
viewing the remote access log and for setting device options. Refer to “Device Management
(Administrator)” on page 9-10.

Password

If no password is set, which is the factory default, remote access to the instrument is
unrestricted and any user who knows the instrument IP address can connect to it, provided
the device 1sn’t currently reserved by another client. When a password is set, it is required
upon login. To clear the current password, click the Reset button. This password is different
from the administrator password described under “Device Management (Administrator)”.
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9-3 Web Remote Control Interface

Home

Remote Control Capture Screen Capture Trace File List

Device Management Logout

Change Password

New Password

Confirm Password

Save Reset

The mstrument Master Reset function will restore the defaults,
Master Reset is found under Shif, 8, Svstem Oprions, Reset, Master Reset.

Clicking the Reset button above will clear the current password.

Default: None

Change Instrument Name

New Name

Save

This is a name that can be used to identify this instrument.

The mstrument name can be viewed and set from the system menu
The Name option 1s found under Sift, 8, System Options, Name.

Default: None

Change Session Time

Time Requested (up to 10 hours): 0 v hours 0 ¥ mnutes

Update

Change the amount of time the instrument is reserved.

Figure 9-7.

Device Management Page

Instrument Name

The instrument name, if defined, is displayed in the green banner at the top of the page. It is
useful in identifying the instrument when you have more than one instrument connected. The
name can be assigned remotely from this Device Management page, or it can be set from the
instrument's System Options menu. Note that this instrument name is not a "hostname" as

used in an Ethernet router.

Session Time

Use the pull-down menus to select the time, in hours and minutes, before the remote session
times out. Click Update to reset the session timer at the specified duration. At the end of the
selected time period, a message notifying the user that the session has expired will display.

172.26.202.155 says:

Session has expired, returning to the login page

Figure 9-8.

Session Expired
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Web Remote Control

Device Management (Administrator)

Logging in as Administrator gives you access to additional functions associated with the
instrument’s remote connection log and the display of information on the Login page.

Home Remote Control Capture Screen Capture Trace File List

Device Management Logout

Change Password

New Password

Confirm Password

Save Reset

The mnstrument Firmware Update will restore the default password

Clicking the Reset button above will reset the password to default.

Default: Admin

Access Log
OO . PO
2016 Apr 01, 01:35PM  Admin Fail 172.26.202.96
2016 Apr 01, 01:37PM  Admmn Success 172.26.202.246
2016 Apr 01, 01:39PM  Admm Success 172.26.202.96
2016 Apr01. 01:41 PM  User Success 172.26.202.96
2016 Apr01. 01:44PM  User Success 172.26.202.96
2016 Apr01. 01:45PM  Admin Success 172.26.202.96
| Download Log | | Clearlog |

Device Options

¥ Show device banner on Login page

expected, but not warranted -
performance. They do not
guarantee the performance of

any individual product. P

Save

Disclaimer Text

Default: None

Change Instrument Name

New Name

Save

This 1s a name that can be used to 1dentify this mstrument.

The instrument name can be viewed and set from the system menu
The Name option is found under Shift, 8, Svstem Options, Name.

Default: None

Change Session Time

Time Requested (up to 10 hours): 0 v hours |0 v | minutes

Update

Change the amount of time the instrument is reserved

Figure 9-9. Device Management Page (Administrator)
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Administrator Password

A password is always required to log in as Administrator. The password is case-sensitive,
with “Admin” as the factory default. To change the password, type your new entry twice and
click Save. See Figure 9-9 on page 9-10.

To restore the default password, click the Reset button. The administrator password is also
reset to default each time you update the instrument firmware.

Access Log

The Access Log is viewable only when you are logged in as Administrator. It contains the date
and time, success or failure status, and user information for up to 50 most recent login
attempts. To save a copy of the log to the default download location on your control device,
click Download Log. The saved file is a comma-delimited CSV file that can be opened with an
application like Microsoft Excel. Click the Clear Log button to empty the Access Log.

Some operating systems, such as iOS, do not support a user-accessible file
Note system. Consequently, the download function is not possible if your control device
is an Apple iPhone, for example.

Device Options

When logged in as Administrator, you have the option to turn on or off the optional text
message and the green banner on the Login page.

For security reasons, for example, you may not want the instrument IP address to display
during login. To hide the banner, deselect the Show device banner on Login page checkbox.
See Figure 9-9 on page 9-10. After changing the Show/Hide setting, click OK in the Banner
Visibility message box. You may need to scroll the browser page to bring the message box into
view.

The factory default is to show the banner. Note that this device option only affects the Login
page. Figure 9-10 illustrates the Login page with no banner.

V4] Anritsu S362E Remote Acc X

——

€ - € [[317226202.155/Login w

Specifications describe the warranted performance of the
instrument. Typical specifications. noted in parenthesis ().
describe performance that will be met by a mimimum of 80 %
of all products. They do not include guard bands and are not
warranted. Nominal specifications are generally representative
of the expected performance. They are not tested and not

J warranted.

Password:
#| Login as Administrator
Time Requested (up to 10 hours): 1 v|hours 0 ¥ minutes

Login

Enter your password and press Login to continue.

Figure 9-10. Login Page with Optional Text and No Banner
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To add a disclaimer or any other message to the Login page, enter the appropriate text in the
text box under the Device Options section of the Device Management page, then click Save.
See Figure 9-9 on page 9-10. Click OK in the update status message box (Figure 9-11). You
may need to scroll the browser page to bring this message box into view.

New disclaimer text successfully updated

OK

Figure 9-11. Disclaimer Text Update Status

Figure 9-10 on page 9-11 shows an example of optional text on the Login page. To remove the
message, delete it from the Disclaimer Text box on the Device Management page and click
Save, then OK.

Instrument Name

The instrument name function is the same whether you are logged in as Administrator or as a
regular user. Refer to “Instrument Name” on page 9-9.

Session Time

The session time is set in the same manner, whether you are logged in as Administrator or as
a regular user. Refer to “Session Time” on page 9-9.

Logout

Exits Web Remote Control and displays the Login page. To start a new session, enter the
password if required, then select the session time and click Login.

If you close the Web Remote Control browser window without logging out, there
Note may be a slight delay before the instrument is released. During this time,
connection attempts by other users will fail.
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Appendix A — Measurement Guides

A-1 Introduction

This appendix provides a list of supplemental documentation for Site Master features and
options. These manuals are available as PDF files on the Anritsu website.

Table A-1. Analyzers and Analyzer Options (Sheet 1 of 2)

Site Master Feature (Required Option)

Related Document
(Part Number)

All Anritsu Handheld Instruments

Important Product
Information, Compliance
and Safety Notices
(10100-00065)

Spectrum Analyzer

PIM Hunting

Interference Analyzer (Option 25)
Channel Scanner (Option 27)
C/W Signal Generator (Option 28)
Gated Sweep (Option 90)
Coverage Mapping (Option 431)
EMF Measurements (Option 444)
AM/FM/PM Analyzer (Option 509)

Spectrum Analyzer
Measurement Guide
(10580-00349)

High-Accuracy Power Meter (Option 19)
Power Meter (Option 29)

Power Meter Measurement

Guide (10580-00240)

Cable and Antenna Analyzer

Cable and Antenna
Analyzer Measurement
Guide

(10580-00241)

Bias-Tee (Option 10)
2-Port Transmission Measurement (Option 21)

2-Port Transmission
Measurement Guide
(10580-00242)

Maintenance Manual

Site Master Maintenance
Manual (10580-00253)

SCPI Programming Manual

Site Master Programming
Manual (10580-00256)

PIM Analyzer (supported on legacy instruments only)

PIM Master User Guide
(10580-00280)

CPRI LTE RF Measurements (Option 752; requires Option 759)
The combination of Option 752 and Option 759 is functionally
identical to obsolete Option 751.

CPRI LTE RF Analyzer
Measurement Guide
(10580-00415)
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Table A-1. Analyzers and Analyzer Options (Sheet 2 of 2)

Related Document
Site Master Feature (Required Option) (Part Number)

OBSAI LTE RF Analyzer
OBSAI LTE RF Measurements (Option 753; requires Option 759) | Measurement Guide
(10580-00434)

EMF Measurement Guide
(10580-00455)

EMF Measurements (Option 444)

Performance Specifications Site Master Technical Data
P Sheet (11410-00484)

A complete suite of PC Tools for Anritsu Handheld RF Instruments is available for download
at anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box.
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Appendix B— LAN and DHCP

B-1 Introduction

This appendix describes network connections for the Site Master. Ethernet option is required.

B-2 LAN Connection

The RdJ-45 connector is used to connect the Site Master to a local area network. Integrated
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to
show that LAN traffic is present.

B-3 Ethernet Configuration

The instrument IP address is set by pressing the Shift key, then the System (8) key followed
by the System Options submenu key and the Ethernet Config submenu key. The instrument
Ethernet address can be set automatically using DHCP, or manually by entering the static IP
address, gateway address, and subnet mask.

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the
process of setting IP addresses for devices that use TCP/IP, and is a common method of
configuring a device for network use.
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B-3 Ethernet Configuration

LAN and DHCP

Ethernet Menu
Key Sequence: Shift, System (8) > System Options > Ethernet Config

Ethernet

Type
Manual DHCP

Field

1P G-Way Sub

First Octet

<

Second Octet

—<

Third Octet

—

Fourth Octet

Type

Manual DHCP: Press the Type submenu key to select whether the IP

Y |address will be entered manually or will be supplied automatically by a

network DHCP server. See Figure B-2 and Figure B-3 on page B-3.

If Manual is selected, use the submenu keys or the Left/Right arrow keys to
select the field that is to be modified in the Ethernet Editor dialog. Use the
numeric keypad, the Up/Down arrow keys, or the rotary knob to enter the
values. Press Enter to apply the changes, or press the Esc key to exit
Ethernet Configuration without making changes.

If DHCP is selected with the Type key, press Enter to close the Ethernet
Editor dialog, then press Shift, System, and Status to view the IP address
assigned by the DHCP server. Press Esc to close the Status screen.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet
Protocol Property to be edited.

First Octet: Moves the cursor to the leftmost column of the selected IP
properties field.

Second Octet: Moves the cursor to the second column from the left of the
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the
selected IP properties field.

Fourth Octet: Moves the cursor to the fourth column from the left of the
selected IP properties field.

Figure B-1.

Ethernet Menu
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DHCP

DHCP stands for Dynamic Host Configuration Protocol. It is a protocol that allows a server to
dynamically assign IP addresses to devices that are connected to the network. Most networks
include a DHCP server to manage IP addresses.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic
IP operation, the IP address in use may change from use to use. The DHCP server hands out
IP addresses on a first come, first served basis. As soon as the device is disconnected from the
network, the IP address that it was using becomes available to lease to the next unit that
requests an IP address. Normally, some amount of lag time is present on the DHCP server
end, so if the device is connected again reasonably soon, then it may end up with the same
address.

When a DHCP server is not available, a static IP address can be used. A static IP addressis a
fixed address. After being set, it will always remain the same, and care must be taken to not
conflict with other equipment on the network.

When using a static IP address on an established network, always request the static IP
address from the network administrator. Randomly choosing a static IP address on an
established network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a static IP address:

IP Address

This is the static IP address on the network. Static IP addresses are necessary when you have
no physical access to the instrument, or any other way to determine the instrument’s IP
address assigned by the DHCP server.

Default Gateway

Often when a static IP address is assigned, a default gateway is also identified. If the default
gateway is unknown, then type in the static IP address so that the static IP address and
default gateway are the same number.

Subnet Mask

This parameter is usually extracted from the static IP address based on the class of the
address and determines the destination of any broadcast messages that might be sent from
the instrument. It can be customized if necessary. The subnet mask may also be provided
with the static IP address.

Example 1

In this example, a static IP address has been chosen because no network DHCP service is
available. The instrument is connected to the network port on the PC with a crossover
Ethernet cable (not included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2
Default Gateway: 10.0.0.2
Subnet Mask: 255.255.0.0
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Example 2

In this example, the static IP address has been assigned with an associated gateway and
subnet mask:

IP Address: 153.56.100.42
Default Gateway: 153.56.100.1
Subnet Mask: 255.255.252.0

B-4 ipconfig Tool

A few tools that are built into the Microsoft Windows operating system can assist in making
some determinations about the network to which the PC is connected. Typing ipconfig at a
command prompt produces a display of information about the in-use parameters of the PC
and its network connection. Following is an example of the typical results expected:

The ipconfig display does not report whether the information is from a DHCP

Note server or from a static IP setup.

Y:\>ipconfig
Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix. : us.anritsu.com
IP Address. . . . . . . . .« .« . . 172.26.202.172
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.26.200.1
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B-5 Ping Tool

Another tool that can find out if a selected IP address is already on the network is ping. Ping
is a harmless way to determine if an address is found on the network, and (if it is found) to
receive a reply. Basically, the ping function sends out a request to a specific address to
determine if a computing device is connected to the network at that address. If a valid
connection is found, then a copy of the signal (that was sent) is returned. If a connection is not
found, then the response is “request timed out”, which means that no reply was received from
that TP address.

Y:\>ping 172.26.202.172

Pinging 172.26.202.172 with 32 bytes of data:

Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Ping statistics for 172.26.202.172:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:

Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms
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Appendix C — Glossary of Terms

C-1 Introduction

The following terms are related to this product and technology.

C-2 Glossary

3 dBrule :

Adapter :

Adaptive Array
Antenna :

ADC :

Analog System :

Analog
Transmission :

The 3 dB rule provides a means to estimate relative power values. A 3
dB gain indicates that power increases to twice the power (a multiple of
2). A 3 dB loss indicates that power decreases to half the power (a
multiple of 1/2). A system with 40 watts of input power and a 6 dB
insertion loss will have only 10fwatts of output power (a multiple of 1/2
for each 3 dB loss, or 1/4 of 40 watts).

A fitting that supplies a passage between two sets of equipment when
they cannot be directly interconnected.

Adaptive array antenna is a type of advanced ’smart’ antenna
technology that continually monitors a received signal and dynamically
adapts signal patterns to optimize wireless system performance. The
arrays use signal processing algorithms to adapt to user movement, to
changes in the radio-frequency environment, and to multi-path and
co-channel interference.

Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device
that converts continuous signals to discrete digital numbers. The
reverse operation is performed by a digital-to-analog converter (DAC).
ADC can uniquely represent all analog input values within a specified

total input range by a limited number of digital output codes. Refer also
to DAC.

An Analog system uses an analog transmission method to send voice,
video and data-using analog signals, such as electricity or sound waves,
that are continuously variable rather than discreet units as in digital
transmissions. Mobile analog systems include AMPS, NMT and
ETACS.

Analog Transmission refers to signals propagated through the medium
as continuously varying electromagnetic waves.

Site Master User Guide
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Glossary

Glossary of Terms

Antenna :

Antenna
beamwidth :

Antenna Directivity :

Antenna Efficiency :

Antenna Gain :

Antenna, Isotropic :

Antenna, Parabolic :

Attenuation :

Attenuator :

Antenna is a device which radiates and/or receives radio signals,
including RF, microwave, and RADAR.

Antenna beamwidth, also known as the half-power beamwidth, is the
angle of an antenna pattern or beam over which the relative power is at
or above 50% of the peak power.

Antenna directivity, also known as antenna gain, is the relative gain of
the main beam of an antenna pattern to a reference antenna, usually an
isotropic or standard dipole. Antenna Directivity is the percentage of
radiated signal transmitted or received in a given direction related to
beamwidth.

Antenna Efficiency is the percentage of theoretical gain actually
realized from an antenna.

Antenna gain, also known as antenna directivity, is the relative gain of
the main beam of an antenna pattern to a reference antenna, usually an
isotropic or standard dipole. Antenna Gain is the effectiveness of a
directional antenna expressed as the ratio of input power of the
directional antenna to input power of an isotropic radiator to provide
the same field strength in the desired direction. Sometimes related to a
dipole antenna.

An 1sotropic antenna is a theoretical point source radiating a spherical
power envelope.

A parabolic antenna is an antenna utilizing a reflector that is shaped as
a paraboloid in order to both concentrate the radiated signal into a
beam and to provide considerable gain. Beamwidth varies inversely and
gain varies directly with the size of the antenna and with frequency.

Attenuation refers to decreasing in signal magnitude between two
points. These points may be along a radio path, transmission line or
other devices.

Attenuator is a device specifically designed to decrease the magnitude
of a signal transmitted through it.
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C-2 Glossary

Average power :

Backhaul :

Band Pass Filter :

Bandwidth :

Bandwidth Ratio :

BER:

BERT :

Average power is the peak power averaged over time and is usually
applied to pulsed systems where the carrier power is switched on and
off.

In wireless technology, backhaul refers to transporting voice and data
traffic from a cell site to the switch.

A Band Pass Filter is a radio wave filter with a specific range of
frequencies in which it is designed to pass. It rejects frequencies outside
the pass-band range. A resistor-inductor-capacitor circuit is an example
of a Band Pass Filter.

Bandwidth usually identifies the capacity of a circuit or amount of data
that can be sent through a given circuit. It may be user-specified in a
PVC. It is an indication of the amount of data that is passing over a
medium. Also, bandwidth is the portion of the frequency spectrum
required to transmit desired information. Each radio channel has a
center frequency and additional frequencies above and below this
carrier frequency which is used to carry the transmitted information.
The range of frequencies from the lowest to the highest used is called
the bandwidth.

Bandwidth Ratio is the ratio of two devices having differing
bandwidths, not necessarily in the same frequency spectrum.

Bit Error Rate or Bit Error Ratio (link quality specification/testing)
(BER) is a measure of transmission quality. The ratio of error bits to the
total number of bits transmitted. A bit error rate of 10-6 refers to an
average of one error per million bits. It is generally shown as a negative
exponent, (for example, 10-7 which means 1 out of 107 bits are in error
or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of
a sequence of message bits that are in error.

Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of
the T1 or digital line. By sending a known pattern to another device
across the span, the far end device can compare incoming pattern to its
own, thereby indicating bit errors on the line.
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Broadband :

Calibration :

CCDF:

Cell :

Cell Delineation :

Cell Site :

Broadband refers to telecommunication that provides multiple channels
of data over a single communications medium, typically using some
form of frequency or wave division multiplexing. It is a service or
system requiring transmission channels capable of supporting rates
greater than the Integrated Services Digital Network (ISDN) primary
rate.

When making measurements, the instrument must be calibrated in
order to remove residual errors due to measurement setup conditions.
Anritsu recommends performing the calibration under the same
conditions as the measurement: temperature, frequency, number of
points, source power, and IFBW. Calibrations standards with known
reflection coefficients are used to calculate the correction factors. The
calibration must be conducted using the appropriate standards at the
open end of any test port cables and adapters that are connected to the
instrument. This ensures that the match, phase length, and loss of
these cables and adapters are all accounted for. For optimal
performance, high quality phase-stable cables and precision adapters
must be used.

Complementary Cumulative Distribution Function (CCDF) is a method
used to characterize the peak power statistics of a digitally modulated
signal. The CCDF curve can be used to determine design parameters for
CDMA systems (such as the amount of back-off to run in a power
amplifier).

In wireless communication, a Cell is the geographic area encompassing
the signal range from one base station (a site containing a radio
transmitter/receiver and network communication equipment). Wireless
transmission networks are composed of many hexagonal, overlapping
cell sites to efficiently use radio spectrum for wireless transmissions.
Also, cell is the basis for the term ’cellular phone.’

Cell Delineation is the process for recognizing the beginning and end of
ATM cells within the raw serial bit stream.

Cell Site, also called Base Station, is the local cellular tower and radio
antenna (including the radios, controller, switch interconnect, etc.) that
handles communication with subscribers in a particular area or cell. A
cellular network is made up of many cell sites, all connected back to the
switch via landline or microwave.

C-4
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Cellular :

Coaxial Cable :

Configuration
Commands :

COW: :

CPLT :

CPM :

CPRI :

CW:

In wireless communications, cellular refers most basically to the
structure of the wireless transmission networks which are comprised of
cells or transmission sites. Cellular is also the name of the wireless
telephone system originally developed by Bell Laboratories that used
low-powered analog radio equipment to transmit within cells. The
terms 'cellular phone’ or ’cell phone’ are used interchangeably to refer to
wireless phones. Within the wireless industry, cellular is also used to
refer to non-PCS products and services.

Coaxial Cable (Coax) is a type of electrical communications medium
used in the LAN environment. This cable consists of an outer conductor
concentric to an inner conductor, separated from each other by
insulating material, and covered by some protective outer material.
This medium offers large bandwidth, supporting high data rates with
high immunity to electrical interference and a low incidence of errors.
Coax is subject to distance limitations and is relatively expensive and
difficult to install.

Configuration Commands are commands that are issued to an
instrument and that change a specific instrument configuration.

Cell site On Wheels (COW) is a mobile site placed at a location to fill in
or increase coverage.

Cell Site on Light Truck (CPLT) is a mobile site on a vehicle placed at a
location to fill in or increase coverage.

Continuous Phase Modulation (CPM) is a phase modulation technique
employing smooth transitions between signal states. This reduces
sidelobe spectral energy and improves co-channel performance.

The Common Public Radio Interface (CPRI) is a protocol standard for
wireless communications that defines the digital interface of radio base
stations between remote radio heads, also referred to as Radio
Equipment (RE), and the Radio Equipment Controller (REC).

Continuous Wave (CW)
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DANL :

dB:

dBc:

dBd:

Displayed Average Noise Level (DANL): Displayed average noise level
is sometimes confused with the term Sensitivity. While related, these
terms have different meanings. Sensitivity is a measure of the
minimum signal level that yields a defined signal-to-noise ratio (SNR)
or bit error rate (BER). It is a common metric of radio receiver
performance. Spectrum analyzer specifications are always given in
terms of the DANL. One of the primary uses of a spectrum analyzer is to
search out and measure low-level signals. The limitation in these
measurements is the noise generated within the spectrum analyzer
itself. This noise, generated by the random electron motion in various
circuit elements, is amplified by multiple gain stages in the analyzer
and appears on the display as a noise signal. On a spectrum analyzer,
this noise is commonly referred to as the Displayed Average Noise
Level, or DANL 1. While there are techniques to measure signals
slightly below the DANL, this noise power ultimately limits our ability
to make measurements of low-level signals.

Decibel or deciBel (dB) is a logarithmic ratio of the difference between
two values (a logarithm ratio is equal to 10 times). dB is a unit for
measuring relative power ratios in terms of gain or loss. The units of dB
are expressed in terms of the logarithm to base 10 of a ratio and
typically are expressed in watts. For example, a -3 dB loss indicates a
50% loss in power; a +3 dB reading is a doubling of power; 10 dB
indicates an increase (or a loss) by a factor of 10; 20 dB indicates an
increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a
loss) by a factor of 1000. Common values of dB expressed in ratios: 0 dB
=1:1,10dB =10:1, 20 dB = 100:1, 30 dB = 1000:1, -30 dB = 0.001:1 [or
(1/1000):1].

Decibels referenced to the carrier (dBc) is a technique for expressing a
power measurement in logarithmic form using the carrier power as a
reference. The units are used to describe how far down signals and noise
are relative to a known signal. Typical use of this term is to describe
spurious signals and noise compared to a desired transmit signal.

Decibels referenced to a dipole antenna (dBd) is a technique for
expressing a power gain measurement in logarithmic form using a
standard dipole antenna as a reference. dBd is a measurement of signal
gain used in radio antenna design. Pecifically, dBd referrs to signal gain
in a dipole radiator.
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dBm :

DHCP :

DSP:

DSRC:

DTF :

FFT :

Flash Memory :

dBm is an absolute measurement of power relative to 1 milliwatt. In
other words, dBm is a decibel value referenced to a milliWatt (dBm).
This is a technique for expressing a power measurement in logarithmic
form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts
(W) to one milliwatt (1mW). dBm, therefore, represents absolute power.
Examples are: 0 dBm = 1.0 milliwatt, 10 dBm = 10 milliwatt, 30 dBm =
1000 milliwatt = 1 watt.

Dynamic Host Configuration Protocol (DHCP)

Digital Signal Processing (DSP)

Dedicated Short Range Communications (DSRC): DSRC is a system
that is intended for communications between two vehicles, or from one
vehicle to a roadside network. Refer to IEEE 802.11p.

Distance-To-Fault (DTF) is the distance from the instrument output
connector (or the end of a test lead) to a problem area, as indicated by a
peak in the displayed signal. DTF measures the location and reflection
size of impedance mismatches. This is typically a diagnostic
measurement, not a pass/fail judgement measurement. DTF is used to
identify and locate faults within an antenna system when the system is
failing to meet the specified return loss or VSWR limits. DTF is also
useful to verify the total length of a coaxial cable assembly.

Fast Fourier Transform (FFT) is an efficient algorithm to compute the
Discrete Fourier transform (DFT) and its inverse. FFTs are of great
importance to a wide variety of applications, from digital signal
processing to solving partial differential equations to algorithms for
quickly multiplying large integers.

Flash memory is a non-volatile solid state storage device that is
packaged as a chip. It can be electrically erased and reprogrammed. It is
primarily used in memory cards, USB flash drives, MP3 players, and
solid-state drives for general storage and transfer of data between
computers and other digital products. It is a specific type of EEPROM
(electrically erasable programmable read-only memory) that is erased
and programmed in large blocks.
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GPS:

Impedance :

Insertion Loss :

IP Address :

The Global Positioning System (GPS) is a space-based global navigation
satellite system (GNSS) that provides reliable location and time
information in all weather and at all times when and where an
unobstructed line of sight is available to four or more GPS satellites.
The system is maintained by the United States government and is
freely accessible by anyone with a GPS receiver. The Global Positioning
System is making it possible for people using ground receivers to
determine their geographic location within 10 meters to 100 meters.
The satellites use simple mathematical calculations to broadcast
information that is translated as longitude, latitude, and altitude by
Earth-based receivers.

Impedance is a measure of RF component electrical resistance,
measured in ohms. In most cable and antenna systems, the standard
impedance is 50 ohms.

Insertion Loss (or Cable Loss) is a measure of the total amount of signal
energy absorbed (lost) by the cable assembly. It is measured in dB. S21
(an S-Parameter) is another name for this measurement.

An Internet Protocol address (IP address) is usually a numerical label
that is assigned to each device (computer or printer for example) that is
participating in a computer network that uses the Internet Protocol for
communication. An IP address serves two main functions: location
addressing and host (or network) interface identification. The Internet
Protocol originally defined an IP address as a 32-bit number. This was
known as Internet Protocol Version 4 (IPv4), which is still in use.
Growth of the Internet requires a new addressing system. An Internet
Protocol Version 6 (IPv6) that uses 128 bits for the address was
developed in 1995, and it is standardized as RFC 2460. IPv6 began
being deployed worldwide in the year 2000. IP adresses are binary
numbers, but they are usually stored in text files and displayed in
human-readable notations, such as decimal nnn.nnn.nnn.nnn or
172.16.255.1 (for IPv4), and hexadecimal
NnNNn.nNNN.NNNN.ANNN.ANNN.NNNN.NNNN.ANNN OF
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal
group (nnn) represents values from 000 to 255, or binary values of 8
bits. In IPv6, each hexadecimal group (nnnn) represents values from
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111
1111 1111 1111).
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IPVv6 :

LST:

NF :

OBSAI :

OBW :

OSL:

Internet Protocol Version 6 (IPv6) is a numerical label that is used to
identify a network interface of a computer or other network node
participating in an IPV6-enabled computer network. IPv6 uses 128 bits
for the address (as compared to an IPv4 address, which is defined as a
32-bit number). Pv6 was developed in 1995, and it is standardized as
RFC 2460. V6 began being deployed worldwide in the year 2000. I
addresses are binary numbers, but they are usually stored in text files
and displayed in human-readable notations, such as hexadecimal
NNNN.NNNN.NNNN.NNNN.ANNN.ANNN.NNNN.ANNN OF
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex| = 65535 [Dec]).
Ea hexadecimal group (nnnn) represents values from 0000 totFFFF, or
binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111).

Line Sweep tools (LLST) is PC-based post-processing software that
efficiently manipulates line sweep and PIM traces for reporting
purposes.

Noise Figure (NF) is a measure of degradation of the signal-to-noise
ratio (SNR) that is caused by components in a radio frequency (RF)
device. The noise factor (F) of a system is defined as the signal-to-noise
ratio of the input power of the system divided by the signal-to-noise
ratio of the output power of that system. F (the noise figure) is defined
as the decibel value of the noise factor. NF = 10log (F) where log uses
the base 10, or common log. This formula is valid only then the input
termination is at standard noise temperature.

The Open Base Station Architecture Initiative (OBSAI) specifications
define a set of requirements for a wireless base transceiver station
(BTS). Reference Point 3 (RP3) within the OBSAI specifications defines
the digital interface between the Base Band Module (BBM) and the
Radio Frequency Module (RFM). This is an alternative to the
traditional Radio Frequency (RF) coaxial connection, or the CPRI
digital interface.

Occupied Bandwidth (OBW) is a measure of the bandwidth containing
99% of the total integrated power of the transmitted spectrum, centered
on the assigned channel frequency. Interference to other channels or to
other systems can occur if OBW 1is too large.

OSL or Open Short Load calibration method for coaxial line types.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
SSL or Offset Short 1, Offset Short 2, Load calibration method for
waveguide line types.
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OSLT:

OTA:

Return Loss :

RF :

SCPI :

SOLT :

OSLT or Open Short Load Thru calibration method for coaxial line
types. Calibrations standards with known reflection coefficients are
used to calculate the correction factors. Refer to Calibration. Compare
this with SSLT or Offset Short 1, Offset Short 2, Load, Thru calibration
method for waveguide line types.

Over The Air (OTA): OTA refers generally to any transfer of information
or signal that takes place in a wireless environment, rather than using
a wired connection. OTA is usually used in connection with a standard
defining the provisioning of mobile devices and applications, such as
downloading or uploading content or software, and commonly used in
conjunction with the Short Messaging Service (SMS). SMS OTA
Messages contain information that is used to configure the settings of a
WAP browser in a mobile phone (refer to SMS and WAP).

Return Loss is a measurement (in dB) of reflected energy caused by
impedance mismatch. May also be referred to as S11. Although S11
values are expressed as negative numbers, Return Loss values are
expressed as positive numbers because by definition the iLossi
expression implies a negative sign. The higher the value, the better the
impedance match (think of a large negative number being less than a
smaller negative number). 40 dB is nearly ideal. Only 0.01 % of the total
transmitted power is reflected if the Return Loss measurement value is
40 dB. A measured value of 0 dB would be a complete reflection, or
stated another way, 100 % of the transmitted power is reflected back.
Return Loss is typically a pass/fail measurement.

Radio Frequency (RF) is the frequency of radio sine waves. RF generally
refers to wireless communications within a frequency range of 3 kHz to
300 GHz. Formally, according to the Article 2 of the Radio Law, radio
frequency is below 3,000 GHz. Radio frequencies can be used for
communications between a mobile telephone and an antenna mast.

Standard Commands for Programmable Instruments (SCPI)

SOLT or Short Open Load Thru calibration method for coaxial line
types with simple and redundant standards. It is not band-limited. It
requires well-defined standards. It has lower accuracy at higher
frequencies. Calibrations standards with known reflection coefficients
are used to calculate the correction factors. Refer to Calibration.
Compare this with SSLT or Offset Short 1, Offset Short 2, Load, Thru
calibration method for waveguide line types.
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SSL:

SSLT:

VSWR:

Watt :

SSL or Short Short Load or Offset Short 1, Offset Short 2, Load
calibration method for waveguide line types uses Shorts with different
offset lengths. It is a calibration (common in waveguide) with simple
and redundant standards, but it is band-limited. It requires
well-defined standards. It has lower accuracy at higher frequencies.
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
OSL or Open Short Load calibration method for coaxial line types.

SSLT or Short Short Line Thru or Offset Short 1, Offset Short 2, Load,
Thru calibration method for waveguide line types uses Shorts with
different offset lengths. It is a calibration (common in waveguide) with
simple and redundant standards, but it is band-limited. It requires
well-defined standards. It has lower accuracy at higher frequencies.
Offset Short 1 1s 1/8 wavelength, and Offset Short 2 is 3/8 wavelength.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
OSLT or Open Short Load Thru calibration method for coaxial line

types.

Voltage Standing Wave Ratio (VSWR). VSWR is another method to
measure reflected energy caused by impedance mismatch. It is
expressed as a ratio of X:1. VSWR measures the voltage peaks and
valleys. A ratio of 1:1 would be a perfect match. A typical cable and
antenna system would be around 1.43:1 (VSWR) or 15 dB Return Loss.

Watt (W) is a unit of measure for power.
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